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1. Introduction

1.1. General information
This chapter describes:

· the list of DOC functionalities;
· the applications which can be made with DOC.
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1.2. Presentation of the program
DOC is the ABB SACE program for drawing and calculating single-line diagrams of low and
medium voltage electrical plants, for selecting the switching and protection devices and for
verifying coordination of the protections.
DOC is dedicated to all professionals in the electrical sector looking for a precise but simple
and rapid tool, which helps them to do their work.

The main functionalities of the program are:
· Drawing single-line electric diagrams.
· Drawing the key diagram of the auxiliary circuits.
· Drawing and configuring the switchboard front (only for Italy).
· Calculating line current and voltage drops.
· Calculating short-circuit currents.
· Dimensioning low and medium voltage cables.
· Dimensioning switching and protection devices.
· Calculating the temperature rise in ABB modular switchboards.
· Setting and coordinating protection devices.
· Verifying cable protection.
· Printing single-line diagrams and project documentation

The program can calculate electric networks with the following characteristics:
· Medium voltage: Vn ≤ 36kV 50/60Hz

State of the neutral: Insulated / Compensated
· Low voltage: Vn ≤ 1kV 50/60Hz

Three-phase power supplies with and without neutral,
two-phase and single-phase
Distribution system : TT – TN-S – TN-C – IT

· Unlimited number of levels and feeders.
· Several distribution systems in the same network
· Three-phase networks with single-phase and two-phase loads
· Plants with service generator.
· Plants in cogeneration.
· Plants with back-up transformers.
· Island operation, without restrictions to the number of generators
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Colors of the single line diagram

To make this document easier to consult, the images of the single-line diagram have – where
possible – been created on a white background, thus with the same color configuration as
that predefined in the program.
When using the program, you are advised to use the predefined colors (white background
and black, green, yellow or red symbols, depending on their state).
Further explanations about color management are given in chap 2.7

· DOC: Drawing of the Single-line Diagram
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· DOC: Cable Section Calculation; Short-circuit Calculations

DOC: Cable Protection and Discrimination Verification
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DOC: Print-out of Project Documentation
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2. Starting to work with DOC

This chapter describes
· operations prior to drawing the single-line diagram;
· description of the work environment;
· customization of the work environment.

After reading this chapter, the user will be able to:
· customize the appearance of the program;
· select the utility;
· define the general properties of the plant;
· select the layout.
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2.1. Definition of the general plant properties
When a new project is opened, the program proposes a series of consecutive masks for the
purpose of defining all the main characteristics.
Their sequence is proposed automatically by the program, depending on the selections made
by the user.
If required by the operation, the sequence is also run automatically by the program in an
already opened file (e.g. when a transformer or some other electrial devices is inserted in a
layout that is still without a utility).

Plant Wizard - window for defining the project data
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Plant Wizard - window for choosing between single-line diagram and enclosure configurator
(only for Italy)

Plant Wizard - window for choosing the layout
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Plant Wizard - window for choosing the reference standards and utility

Plant Wizard - window displaying low voltage supply
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Plant Wizard - window displaying medium voltage and low voltage supply

Plant Wizard - window displaying network supplied by low voltage generator
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Plant Wizard - window displaying network supplied by medium voltage generator

Plant Wizard – window for defining the switchboards
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2.2. Plant Wizard for LV and MV-LV supply
Use of LV (low voltage) supply

This supply is suitable for:

· -installations for the residential and services-providing sectors or small industrial
applications connected to the low voltage distribution network. Small and medium-
sized installations connected to the distribution network by means of transformer
substations belonging to the public utility company.

· -medium and high-power installations when only the low voltage section need be
studied, where there is no need to coordinate the protections between the medium
voltage side and low voltage side of the transformer/s.

In order to define the supply, DOC requires one of the following parameters:
· the three-phase short-circuit current
· the apparent short-circuit power
Enter one of the two parameters mentioned above and DOC will automatically calculate
the other .

If the parameters of the medium voltage/low voltage transformer/s (transformer substation
belonging to the public utility company) are known, they can be entered in place of the short-
circuit current on the low voltage side or the apparent short-circuit power side.

To enter the values of the transformer/s, enable the fields by selecting the relative box at the
top right of the supply window.
Select the number of transformers in parallel in the substation in the pull-down menu. Up to
a maximum 3 transformers in parallel can be considered.
Now select the power of the transformer in the pull-down menu or type in the required value
in the field. Similarly, select the percentage short-circuit voltage (Ukr) from the pull-down
menu or type in the value.
Using these values, DOC calculates the voltage drop from the transformer secondary to the
last load (without considering the internal voltage drop of the transformer, which would be
counted by DOC if the Single Object “Transformer with 2 windings” with MV-LV supply were
to be used).
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Calculators for LV short-circuit definition – top part of LV supply window

If the exact value of the short-circuit current at the supply is not known, you can use the
short-time withstand current of the main switchboard (Icw), or the breaking capacity value
of the main circuit-breaker.

Regarding  the  characteristics  of  the  low  voltage  circuits,  the  supply  window  allows  you  to
define preset values for the main parameters that characterize the low voltage section of the
installation.
Accurate entry of the parameters will speed up the drawing and data entry steps.
Portions of the installation that must have different values from the preset parameters (e.g.
if a three-phase system with neutral is chosen (Phases = LLLN) but single-phase loads must
also be shown) can be customized afterwards when the drawing is made (Cf. point 3 of
Chapter 3.2)

· Rated voltage: there is a list of normalized voltages. However, you can type in any value
you require between 0V and 1000V

· Distributed phases: all the possible combinations in a three-phase system are available
(LLLN, LLL, LLN, LL, L1N, L2N, L3N)

· Distribution system: distribution systems TN-C, TN-S, TT and IT are available. It is
advisable to enter the distribution system of the supply. Instructions about how to
proceed if sections of the installation have different distribution systems are given
further on (e.g. sections controlled by the TN-S system in installations with TN-C supply)

· Rated frequency: 50 or 60Hz
· Power supply voltage tolerance (+10% or 6% depending on the short-circuit calculation)



DOC – User manual – page 18

“LV supply”: representation on in the single-line diagram

Use of the MV-LV supply
This supply is also suitable for representing the medium voltage section in large installations,
by selecting the MV side switching and protection devices and coordinating them with the LV
side of the installation.
The parameters required to define the supply (normally notified by the public utility
company) are:

· the rated voltage.
· the short-circuit current.
· the earth fault current at the point of delivery.
· the state (insulated / compensated) of the neutral.

The calculator-shaped button allows the short-circuit current value to be entered in an
alternative way, when the apparent short-circuit power is known.
Finally, the earth fault current value can be entered in an alternative way when the capacity
to  earth  or  the  Petersen  coil  parameters  are  known  (only  in  the  case  of  compensated
neutral).
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“MV supply”: Calculator for MV short-circuit definition

Earth fault calculation according to the state of the neutral

The formulae used by DOC for calculating the earth fault are given below with special
attention to the parameters available for defining the MV short-circuit.
System with isolated neutral
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where:

- 3Io [A]: earth fault current detected by the homopolar transformer
- 1.1V  [V]: phase voltage corrected according to the c factor of Standard IEC 60909-0
- f [Hz]: frequency
- Ce  [μF]:  capacity to earth of the network on the supply side of the supply
- Igr  [A]:  real component of the earth fault current due to the resistance of the

Petersen coil (Rp)
- Rp  [Ω]: resistance of the Petersen coil
- Igi [A]: imaginary component of the earth fault current equal to the vector sum of

the capacitive contribution of the network (Ce) and the inductive contribution of the
Petersen coil (Lp)

- Lp  [mH]: inductance of the Petersen coil

The window allows you to define the preset value for the main parameters that characterize
the LV section of the plant.
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Precise setting of the parameters speeds up the drawing and data input stages.
Parts of the plant which must have different parameter values (for example, you select three-
phase distribution (Phases = LLLN) but you also have to represent single-phase loads) can be
customized afterwards when drawing (Cf. point 3 of Chapter 3.2)

· Rated voltage: a list of standardized voltages is available. However, you can still type in a
value between 0V and 1000V as you require

· Distributed phases: all possible combinations in a three-phase system are available
(LLLN, LLL, LLN, LL, L1N, L2N, L3N)

· Distribution system:  TN-C,  TN-S,  TT  and  IT  distribution  systems  are  available.  It  is
advisable to enter the distribution system of the supply. Indications are given below
about how to proceed if there are plant sections with a different distribution systems
(for example, sections managed with the TN-S system in plants with TN-C supply)

· Rated frequency: 50 or 60Hz

“MV supply”: representation in the single-line diagram

Further details about the LV and LV-MV supply

A  simple  double  click  on  the  symbol  of  the  supply  in  the  single-line  diagram  will  call  up  a
window where all the technical data can be entered.
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“LV and MV-LV supply”: supply data entry window

After the drawn single-line diagram has been calculated, the following plant load data are
given in the “plant requirements” area of this window
· Active power
· Reactive power
· Current
· Power factor

Use the “Options command to access further advanced level settings which have already
been pre-defined with values that generally need not be edited.

The advanced settings provided are:
· Choice of Standards for short-circuit calculations, i.e.:

oIEC 60909 (International Standard for 50-60Hz applications)
oIEC 61363 (Naval Applications)
oNFC 15-100  (French Standard)
oSymmetrical components method.

· Choice of Standard for dimensioning cables, i.e.:
oCEI 64-8 (Italian Standard)
oIEC 60092 (Naval Applications)
oIEC 60364 (International Standard)
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oUNE 20460  (Spanish Standard)
oVDE 294 (German Standard)
oNFC 15-100  (French Standard)

· Temperature: value of the ambient temperature (used for calculating temperature
rises in the switchboard) and the temperature inside switchboards (presumed or
calculated by DOC; used to consider a possible temperature derating of the
performance of the protection device)

· Protection of people: contains the parameters used by DOC to verify protection
against indirect contacts: Contact voltage; Tripping time; Resistance of the earth
electrode (cf. Chapter 5.1.1 for a description of their use).

· Automatic selection of the type of circuit-breaker: data for guiding DOC in the
selection of Miniature, Moulded-case or Air circuit-breakers according to the current.

Generator

This supply is suitable for representing plants totally supplied in an island, such as ships or
off-shore platforms.

Selection of the “Generator” supply

The “Generator” supply must not be used in the case of cogeneration or service generators
(Cf. Chapter 3.5)
In these cases it is advisable to use another of the supplies available and subsequently
represent the generator by means of the “Generator” Single Object.

“Generator”: representation in the single-line diagram
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2.3. Selection of the layout
DOC  allows  you  to  define  the  layout  to  use  among  those  available,  when  the general plant
properties are defined (see section 3.1). You can choose from among various different ISO
formats, suitable for drawing both low and medium voltage single-line diagrams and for
drawing low voltage switchboard fronts.

There is a preview of all the available layouts to facilitate your choice

Preview of the available layouts

How to change the layout when the diagram is drawn

When you are drawing a diagram, it may be necessary to change the layout in relation to the
one selected previously .
You can do this by using the “Change layout ” command in the “Home” tab and selecting the
icon on the left.
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2.4. Definition and editing of the switchboard list
When the general plant properties are defined (see section 2.1), DOC also allows you to define
the list of switchboards to use for the project you want to develop.
You can assign all the devices in the diagram to one of the switchboards in this list.

Window for defining the switchboards in Plant Wizard.

How to display and edit the list of switchboards outside the Plant Wizard
definition procedure

When  a  diagram  is  being  drawn,  it  may  be  necessary  to  change  the  list  of  switchboards  or
change their properties with respect to those defined during the Wizard procedure.
This can be done with the “Switchboards”  command  (“Tools” menu in the “Home” tab) by
selecting the icon displayed on the left.

Window for defining/editing the switchboards available in any project development stage
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2.5. Main window
(1) Quick access menu

The Quick Access Toolbar, which can be displayed by using button “D”, provides you with
commands for managing the project file, the print options and DOC options.

(2) Ribbon toolbar
The Ribbon area contains all the commands for creating and editing the project. It is divided
into  tabs  (“HOME”,  “LV  SYMBOLS”,  “MV  SYMBOLS”,  “SWITCHBOARD  CONFIGURATOR”  and
“INFO”) and offers all the functionalities for drawing and managing the project.

(3) Status bar
Area that contains certain, frequently used commands such as next page, previous page,
zoom, etc.

(4) Drawing sheet
This  is  the  area  in  which  the  project  to  be  created  with  DOC  takes  shape.  It  represents  the
page, complete with layout, as it can be printed for the purpose of documenting the project
itself.

DOC work area
LV SYMBOLS tab
Tab containing all the commands and components for drawing a low voltage plant.

Low Voltage symbols
MV SYMBOLS tab
Tab containing all the commands and components for drawing a medium voltage plant.
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Medium Voltage symbols
SWITCHBOARD CONFIGURATOR tab (only Italian market)
Tab containing all the commands and components for creating a switchboard.

Switchboard design elements
INFO tab
Tab with links to the manuals and other useful information.

Manuals and documents
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2.6. Workflow
Comply with the following work flow to work with DOC in the best way:
Draw the Medium Voltage network using the tools in the “MV SYMBOLS” tab dedicated to this
type of functionality (Cf. Chapter 3.4).
Draw  the  Low  Voltage  outgoing  feeders  using  the  tools  in  the  “LV SYMBOLS” tab, which
contains all the DOC functionalities for drawing LV layouts (Cf. Chapters 3.2 and 3.3).
Calculation and dimoensioning of the plant using the specific button in the “HOME” tab (Cf.
Chapter 4).
Verification and drawing of the curves using the specific button also in the “HOME” tab (Cf.
Chapter 5).
Functional drawing of the auxiliary circuit diagrams using the specific menu “Other apparatus”
in the “LV SYMBOLS” tab (Cf. Chapter 6).

Creation and printing of the documentation using the “Document manager” function in the
menu of the same name in the “HOME” tab (Cf. Chapter 7).
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2.7. Customizing of layout and “Quick Access” menu colors

The appearance of DOC’s main window can be customized by changing the colors of the
layout. In addition, a bar for quick access to the most frequently used commands can be
created by selecting the command in the pull-down menu of button D (“Quick Access”).
Similarly, you can also edit the commands in the quick access menu as desired.
This allows you to continue working in your habitual way.

Colors

Use the “Options” command in the “Quick Access” menu to change the colors.
The settings are on the “Colors” page.

The colors which define the state of the Single Objects can be changed, as can the work sheet
background color.

Window for customizing the colors

The meanings of the main preset colors used by the program are described below:
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Color Meaning
Black Single Object to be dimensioned and verified
Green Single Object dimensioned correctly
Orange Single Object with missing elements
Red Single Object with errors
Olive Green Single Object off, not supplied in the current network configuration

Quick access menu

The commands in the Quick Access menu can be easily customized. There is a specific menu
for this purpose, as shown in the figure below.

Menu for customizing the Quick Access menu
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3. Drawing the single-line diagram

This chapter describes:
· drawing the single-line diagram of Low Voltage networks;
· drawing the single-line diagram of Medium Voltage networks;
· network data input;
· management of several power supplies in the same project.

After reading this chapter, the user will be able to:
· use the Single Objects and Macro Objects for drawing the single-line diagram of Medium and Low

Voltage networks;
· draw all types of diagrams, even those consisting of several switchboards and shown in several pages;
· define the characteristics of loads and lines;
· configure networks supplied by a power supply and by back-up generators.
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3.1.  General indications about drawing
Once the general properties of the plant and the layout have been defined, the utility symbol
will already be present on the drawing sheet.
You can therefore proceed to draw the single-line diagram as described in this chapter.
.

DOC allows you to use two different types of objects, present in both the “MV SYMBOLS” tab
and “LV SYMBOLS” tab of the program:
· Single Objects
· Macro Objects

Single Objects are blocks  which  represent  a  single  element  of  the  electrical  plant  and  which
allow a single-line diagram to be made (for example: “LV Circuit-breaker”, “LV Cable”, “Generic
load”, “Busbar”, “Motor”, …). By connecting the Single Objects with each other, you can obtain
infinite combinations able to represent any type of plant.
The icons of the Single Objects are in the Toolbars area.
On the other hand, Macro Objects are a combination of several Single Objects already ready to
be drawn with a single click.
Macro  Objects  thus  allow  you  to  draw  much  more  quickly,  at  the  expense  of  the  variety  of
plants which can be shown.
Furthermore, Macro Objects only allow you to draw purely radial networks, whereas the Single
Objects allow meshed type networks to be created, which DOC is able to manage during the
calculations.
The best result is obtained by using both Single Objects and Macro Objects, thus combining the
needs of each particular plant with speedy creation of the diagram.
To draw a Single Object or a Macro Object, just click on the icon that represents it. The Single
Object or Macro Object will be hooked up to the mouse pointer, ready to be drawn with a click
of the left button in the desired position of the diagram.
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3.2.  Drawing with Macro Objects
This chapter describes how to make a single-line diagram using only Macro Objects.
Macro Objects are useful for making a single-line diagram rapidly, starting from the main
device and proceeding on to the load side feeders until the loads are reached.
The program automatically checks to make sure that the single-line diagram is congruent.
Low Voltage Macro Objects
These can be easily found in the “LV SYMBOLS” tab of the Ribbon area

“General” and “Second level General” Macro Objects

“Generic feeder”, “Motor feeder” and “Other Devices” Macro Objects
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1) Start positioning the main circuit-breaker by selecting the “Main Thermal-magnetic CB” icon
from the “Main” menu of the “LV SYMBOLS” tab.
The program will see to stretching the connections so as to take up all the vertical space
available on the work sheet.

1) Main Thermal-Magnetic CB
2) Select the type of feeder to be shown from the “Feeders” menu, e.g. a “Residual current

thermal-magnetic circuit-breaker with generic load” feeder. Hook the Macro Object to the line
on the output from the main circuit-breaker.

3) The feeder line is now connected to the line and the program displays the dialog window for
fast definition of the feeder data.
This allows you to define the main data of the feeder while drawing:
· Phases (single-phase, three-phase with and without neutral)
· Distribution system
· Description of the feeder (for improved flexibility, this is available on two lines)
· Consumption of the generic load (rated current or rated active power and power factor)
· Length and type of cable
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3) Feeder properties fast input window

Remove the check mark from the “Always show” option to disable the feeder fast definition window.
Disabling these functions is useful if you want to edit the data of a feeder in detail.
The window can be re-enabled from the “Quick Access” – “Options” menu in the “Other” page.

Phases and distribution system

The phases and distribution system properties must be consistent in the plant.
This does not mean they must necessarily be the same throughout plant, but that there are
rules which DOC helps you to follow (for example, you can manage sections of plant with a TN-
S or TT distribution system starting from a TN-C supply, or single-phase lines derived from a
three-phase system with neutral. But it is not possible, for example, to derive a single-phase
load  from  a  three-phase  distribution  without  neutral  or  to  derive  an  IT  system  from  a  TN
system without using an insulating transformer which separates the two parts of the plant).

DOC helps the user by showing only properties compatible with the type of distribution
selected.
In the case of incongruence, DOC warns of the incorrect situation during the calculations and
signals the Single Objects by changing their color (Cf. Chapter 2.7).
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Editing of phases and distribution system
The phases and distribution system can be edited in two ways:
· By selecting just one Single Object to be edited, applying the “Properties” command (the

same as a double click on the Single Object symbol) and changing its Phase and/or
Distribution system properties (DOC will only show the values compatible with the
position the Single Object occupies in the plant).

· By selecting several Single Objects to be modified and using the “Properties” command, in
the “Edit” menu. You can change the common properties with the “Common properties
manager” window.

4) Once the main data have been defined, DOC adapts the feeder line in height depending on the
layout, by occupying all the available space.

4) final appearance of a feeder line
5) Repeat the procedure for every other feeder line.

Advice on drawing in columns

There are two important rules to follow to improve the result of a drawing in columns:
· The Macro Objects must be entered in the center of the column. DOC helps you to do this

correctly thanks to the predefined (and unalterable) grid step, with  horizontal and
vertical lines that intersect in the cursor position, following it in its movements, and with
the actual structure of the column layout.

· Do not enter two Single Objects of the same type in the same column (for example, two
“Circuit-breaker” Single Objects): the layout would not be able to host the data of both!

Codification of Single Objects
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DOC automatically codifies Single Objects according to the type of layout:
· Codification follows the Page.Column rule in column layouts.

Different Single Objects drawn in the same column will have the same numbering (Circuit-
breaker –QF1.1; Cable –WC1.1; Load –L1.1).

· In  a  free layout,  Single  Objects  of  the same type will  have incremental  codification.  The
fifth  circuit-breaker  entered  from  the  start  of  the  drawing  will  have  code  “–QF5”  and
could be matched to the third cable “-WC3”.
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3.3. Examples

3.3.1. Switchboard with sub-levels
Using Macro Objects, you can also draw several levels in the same switchboard (for example,
several thermal-magnetic devices subordinate to a single residual current device).

1) Starting from the switchboard already defined in Chapter 3.2, add a “Sublevel pure residual
current CB” Macro Object from the“Sublevels” menu of the “LV SYMBOLS” tab in the first
vacant column. The special line will be added directly on the load side of the sublevel main
device.

1)Sublevel main residual current circuit-breaker

2) Select the type of feeder to be shown from the “Feeders” menu in the “LV SYMBOLS” TAB, e.g.
a "TMd feeder with generic load”. Hook the Macro Object to the line on the load side of the
residual current device.
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2) Feeders protected by a thermal-magnetic device
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3.3.2. Switchboard over several pages
When a switchboard requires more space than the 11 columns available in the layout, the
procedure described in this chapter can be repeated on several pages.

1) After having drawn the part of the switchboard which can be shown on the current page, add
the “Link to feeder” Macro Object from the “Main” Macros to the line.

1) Board with link to page

2) Add a new page to the project with the “Add a new page” command in the “Home” tab, by
clicking on the icon on the left
The settings on the current page, are also kept for the new page.
Chapter 7.4 describes the settings available and how to change them should the new page so
require.
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3) Add the “Line” Macro Object from the “Main” menu of the “LV SYMBOLS” tab to the new
page. The pointer of the mouse must be positioned so as to fall half-way down the first
column.

4)

Once the line has been added, DOC will ask which “Link to page” to connect it to among those
available.
The “Link to page” sign reflects the Page.Column format.
In the case of the image below, link arrival to departure will be connected to link 1.11.
A description can be added to make the links easier to identify.

Dialog window for connecting the “Links to page” “

5) The line on the new page has been added. You can now continue with the switchboard
drawing on the new page!

Browsing through the project pages

When the project consists of several pages, they can be browsed using the “Next page” and
“Previous page” commands in the “Home” tab of the “Document manager” menu. The
commands can also be performed using function keys F12 and F11.
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3.3.3. Diagram with more than one switchboard
If the plant includes several switchboards, they can be drawn in a single diagram with DOC.

1-Assignment of the switchboard of each apparatus must be performed in the manual mode
since DOC stores the switchboard name entered during the diagram editing stage for each
device. This means that the calculation procedures and the type of diagram used will not
change the switchboard name entered by the user in the manual mode for each device.

2-A network consisting of dozens of switchboards and hundreds of circuit-breakers and
cables, can take up a lot of the processor resources and require long processing times.
Should the calculation times become long, it is advisable to divide the project into several
files. This is done by simulating a switchboard with a single generic load of equal power, net
of the demand factor, and by saving the removed switchboard in a new file.
Simulate the network on the supply side in the new file by entering the supply data and
copying the results of the calculation, voltage and short-circuit current of the original
project.

1) A section switchboard that supplies some of the feeders can be derived from the main
distribution board.
The feeder from the main distribution board to the section switchboard is drawn by means of
the “Sub-switchboard feeder,Circuit breaker with Overload and Short circuit protection + RCB”
Macro Object in the “Feeders” menu.
The user can select the type of protection device to be used
.

Feeder for section switchboard

2)  Add a new page as shown in the previous example
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3) Draw the “Arrival” Macro Object from the “Main” menu of the “LV SYMBOLS” tab on the new
page. The mouse pointer must be centered half-way down the first column of the layout.
The program will ask to connect the Macro Object to the relative “Link to page”
”.

Arrival page

4) Draw the general device of the section switchboard by selecting it from the Macro Objects
available in the “Main” Macros toolbar.

5)  Complete the section switchboard with its feeder lines
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Section-switchboard with main switch-disconnector
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3.4. Drawing of an MV-LV single-line diagram with Macro Objects

Once the MV utility has been chosen in “Plant Wizard”, you will be able to identify all the
Medium Voltage Macro Objects in the “MV SYMBOLS” tab of the Ribbon area.
They will be found in the “Typical Unisec units” menu.

“Typical Unisec Units" Macro Objects

Medium Voltage Macro Objects

Each Medium Voltage Macro Object represents a typical compartment of the Unisec secondary
distribution board
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1) Select the compartment you want to use as arrival line from the utility company.

Arrival with typical Unisec compartment

2) Draw the Medium Voltage diagram with the Macro Objects available, already preset to make
up a Unisec board, by placing a typical compartment alongside another.
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MV switchboard comprising 6 typical panels of the Unisec switchboard

3) Add the “Transformers with 2 windings” so as to prepare for drawing the LV section of the
plant. To do this, use a pair of links so as to transfer the MV to the next page.

4) Complete the 2 LV lines with the main circuit-breaker, cable and load to outline the situation
of all the LV loads.

5) MV switchboard with two transformers and two line feeders

5) Add a new page with the “Add a new page” command, available in the “Home” tab of the
“Document manager” menu with the icon shown on the left.

6) Change the layout of the new page with the “Change layout - page dimension ” command,
available in the “Home” tab of the “Document manager” menu with the icon shown on the
left).
Select the layout with low voltage columns.



DOC – User manual – page 47

Changing the layout
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3.5. Drawing and defining a Network – UPS changeover

DOC allows you to define several power supplies in mutual exclusion for the same plant.

1) Draw a network with “LV” supply where a “Generator” Single Object is also present.

Example of a diagram with two power supplies

2) Use the “Scenarios” command in the “Tools” menu.
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 “Scenarios” command window

3) Define the “NETWORK” configuration:
· Double  click  over  the  “<default>”  text  to  rename  the  existing  configuration  in

“NETWORK”;
· Deselect the protection device which connects the “Generator” Single Object to the rest

of the network. In this way, the generator will be disconnected from the plant in the
NETWORK configuration.

4) Define a new “Emergency” configuration:
· Click on the available tab to enter a new scenario;
· Assign the “emergency” name to the new configuration;
· Deselect  the protection device which connects  the supply  to  the rest  of  the network.  In

this way, the supply will be disconnected from the plant in the “emergency” configuration
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Network configurations: “emergency” scenario

5) Once the window for defining the configurations has been closed, part of the network will be
in a different color, depending on the configuration selected.
The color  indicates  that  part  of  network is  “off”,  or  not  supplied (to  change the colors  or  to
know their meaning, Cf. Chapter Error! Reference source not found.)
The unsupplied part of the network will not be considered in the calculation of this
configuration.
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Single-line diagram: “GROUP” scenario

Single-line diagram: “NETWORK” scenario

Use of the “Calculate scenario” option under the “Calculation options” item of the “Options”
command is of particular importance in this context
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Window where the scenario calculation mode is entered

If you opt for the “Actual” value, all the dimensioning will be performed in relation to the
scenario activated at that particular moment.
On the other hand, if the “All” value is entered, dimensioning will take account of the
performance required from every device in all the network scenarios envisaged in the
project: this means that a higher performance level that does not take account of a single
scenario may be required from each device.

The flag on the “Show calculation options before dimensioning” accesses the  “calculation
options” window prior to each dimensioning.
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3.6. How to edit the drawing

This chapter describes the most useful commands for editing the single-line diagram drawing.

Zoom In, Zoom Out and Pan with the mouse
The “Zoom In”, “Zoom Out” and “Pan” commands can be given using the mouse wheel: this
way the relative part of the diagram can be displayed rapidly with the right level of detail.
The “Zoom In”  and “Zoom Out” commands are, respectively, turning and clicking the mouse
wheel upwards and downwards.
The “Pan” command is obtained by keeping the mouse wheel pressed and dragging the page.
These commands are also present in the “View” menu of the “HOME”tab.

Multiple selection by means of selection box
To select several Single Objects it is advisable to:
· Disable any active command by pressing the “Esc” key.
· Click over an empty point of the drawing.
· Create a selection box which touches or completely includes the Single Objects to be

selected.

The selection will consist of all the Single Objects touched or completely included in the
selection box, depending on the first click and the direction in which the Single Objects are
selected.
· If  the first click is on the right of the Single Objects to be selected, DOC will add all the

Single Objects touched by the selection box to the Multiple selection.
· If  the first  click  is  on the left  of  the Single  Objects  to  be selected, DOC will  add all  the

Single Objects completely included in the selection box to the Multiple selection.

Multiple selection by clicking over the Single Objects to be selected
A multiple selection can be created by clicking over each Single Object you want to add to the
selection list. First select all the Single Objects required, then select the Command you want to
apply (for example, the “Properties” command)

Copy –Paste

The “Copy” and “Paste” commands allow a Single Object or a Multiple Selection of Single
Objects to be copied onto different pages of the drawing.
The predefined values of the original Single Objects will be indicated in the pasted Single
Objects.
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These commands are present on the “Clipboard” menu of the “HOME” tab.

Stretch

The “Stretch” command allows the length of “Busbars” and “Connections” to be modified. This
command is present in the “Trasformations” menu of the “HOME” tab.

Connections stretched using the “Stretch” command ”

Add a text

To add text notes to the single-line diagram, use the “Text” command in the “Tools” menu of
the “HOME” tab.
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3.7. Labels
Labels are texts associated with each Single Object which allow the characteristics and
calculation results to be displayed, such as the Iz of a Cable, the Description of a Circuit-breaker
or the short-circuit current at a Busbar.
The position of the Labels depends on the layout.

Layout in columns
The layout in columns shows all the data relative to a Single Object in the layout below it.
The contents of each compartment of the layout is explained in the caption at the bottom left.
You cannot change the layout and results displayed.

Layout: Caption (first column on the left); data of a dimensioned feeder (green color) and data of
an undimensioned feeder (black color)

Free Layout
The free layout shows some of the calculation results in the labels alongside each Single Object
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Labels in a free layout; Label Manager window

Label manager

The Labels show the user the main data of each Single Object.
The Labels can be customized:
· The list of data contained in the Label can be changed by the user with the “Set Labels”

command in the “Tools” menu. There are two predefined Label configurations: one for the
free layout, the other for the layouts in columns. Special Label configurations can be saved
for subsequent use in other projects.

Move labels

Using layouts A3, A2, A1 or A0, which allow free drawing of the single-line diagram, the labels
are shown alongside the Single Objects.
When two or more labels are overlaid, they can be moved with the “Move labels” command.
This command is present in the “Tools” menu of the “HOME” tab.
Change the data shown on a Label

Use the “Set Labels” command in the “Tools” menu to change the list of data shown on a Label.
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Label managr window
The label manager window allows you to define which properties to display in the diagram.
To change the state of a property, first select the Single Object to be modified in the “Object”
menu, then enable or disable a property in the “Properties” list. The selection affects all the
Single Objects in the single-line diagram.
You can also save a label configuration by means of the “Save configuration…” button, and use it
again in another project.
The “Board configuration” and “Free configuration” options refer to the two types of layout:
· “Board configuration” is the layout in columns, available in two variants: one for LV plants

and one for MV switchboards.
· “Free configuration” is the layout without columns, where the labels are displayed beside

each Single Object.

Example of label manager use: Display\Hide the padlock
The padlock icon (Cf. Chapter 4.5) in Labels is used to make the Single Objects, which have been
locked by the user and that DOC cannot change following a calculation, recognizable.
The symbol is very useful during design, but cannot be used in the printing stage.
This means that it may be useful to know how to manage the Labels so as to show or hide the
padlock icon, depending on the task you are performing.
This situation can be managed with two label configurations:
· With padlock
· Without padlock

1) Run the “Set labels” command in the “Tools” menu of the“HOME” tab.
2) Select the “Board configuration” or “Free configuration” option, depending on the layout used
3) Activate the padlock for all the Single Objects. The padlock is managed by the “STATE” property.
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Label manager: STATE label of the LV circuit-breaker

4) Save the configuration with the “Save configuration…” button and assign it the name you prefer.
5) Disable the padlock for all the Single Objects.
6) Save the new configuration as described in point 4).
7) To display of the padlock, run the “Label manager”  command  in  the  “Tools”  menu  of  the

“HOME” tab, select the type of diagram used, board or free and select the configuration where
the padlock is to be displayed from the pull-down menu.

8) Once the two configurations described in points 4) and 7) have been created, you can rapidly
pass  from one to  the other  by  executing the “Set Labels” command and selecting the desired
configuration from the list at the top left.

Single-line diagram with the padlock visible and not visible
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4. Calculation and Dimensioning

This chapter describes:
· the DOC calculation potential;
· results of the calculation;
· verification of existing plants.

After reading this chapter, the user will be able to:
· understand what is calculated by the program;
· understand how the calculations are made;
· resolve any incorrect situations highlighted by the program;
· read the calculation results;
· customize the program choices
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4.1. Calculation and Dimensioning

When the single-line diagram drawing is completed and the data of the Single Objects have
been defined, you can then calculate the single-line diagram.
DOC has a powerful calculation engine able to rapidly and automatically perform long and
complex operations which would take a long time to carry out in the manual mode or using
some other, less powerful software.

In particular the DOC calculation engine is able to:
· Verify correctness of the single-line diagram design
· Calculate the load currents at all points of the diagram
· Calculate the voltage drops
· Balance single-phase - two-phase loads over the three phases
· Calculate the power consumed by the supply and the power factor
· Dimension the cables according to the calculated load currents and/or the voltage drops
· Repeat steps 2 and 3 until all the cables have been correctly dimensioned
· Calculate the maximum and minimum short-circuit currents at all points of the single-line

diagram
· Choose the protection devices according to the load currents, short-circuit currents,

protection of cables and people and, if required, coordinate the protection devices
(discrimination and/or back-up).

The calculations are made using the “Calculate” button of the “Tools” menu in the “HOME”
tab.  All  the calculation parameters  are  preset  so  as  to  meet  the needs of  the more common
plants. Calculation thus begins immediately and does not require any further decisions from
the user.

Advanced calculation settings

Some parameters used in the calculation procedure can be changed by the user.
This operation is generally not indispensable because the parameters are preset so as to satisfy
the most common needs. To view and edit these parameters, you must use the “Options…”
command (in the main windows of the program, e.g. in the Supply window) and select the
“Show calculation settings before dimensioning” box on the “Calculation options” page.
Modification of the advanced calculation options is only recommended for expert users with
special requirements as they concern:
· Definition of the instants at which the short-circuit currents must be calculated;
· Power supply voltage tolerance;
· Reference temperature of the cables for calculating the maximum short-circuit currents;
· Type of over-excitation of the generators in the diagram;
· Manual exclusion of motor contributions in short-circuit current calculations.
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Minimum and maximum fault currents

DOC calculates the Minimum and Maximum short-circuit currents it all points of the network.
Their difference is explained in Standard IEC 60909-0 chapters 2.4 and 2.5 (the differences are
also given in DOC during printing in Printout of the Error! Reference source not found. section;
Error! Reference source not found.).
It is important to underscore that, with regard to the end-of-line fault currents, DOC calculates:
· The Minimum fault current in the cable, used for protection against indirect contacts (Cf.

Chapter 5.1).
· The Maximum fault current in the switchboard on the load side of this line, used for

selecting the Breaking Capacity of the protection devices installed in the switchboard.

Two different short-circuit values are therefore available at the end of the line, defined as
follows:
Maximum short-circuit currents
· Voltage factor cmax (equal to 1.1) is applied to calculate the maximum short-circuit

currents;
· The motors are included if their contribution is more than 5% of the maximum short-

circuit current calculated without this contribution;
· The resistances of the lines (overhead and in cables) are taken at a temperature of 20°C.
Minimum short-circuit currents
· Voltage factor cmin, equal to 0.95, is applied to calculate the minimum short-circuit

currents;
· The contribution of motors is excluded;
· The resistances of the lines (overhead and in cables) are taken at a temperature of 80°C.

The cable resistance values at 20°C and at 80°C can be printed by enabling Printout in the
Error! Reference source not found. section of the Project documentation (Cf. Chapter Error!
Reference source not found..).
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A window showing the state of progress of the process is visible during the calculations.

Calculation window

Messages may appear during the calculations, when significant or abnormal situations occur.
The meaning of the main messages is explained in chapter 4.2.
Depending on what DOC finds, the Single Objects may change color at the end of the
calculations, in accordance with the color profile (Cf. chapter 2.7).
In certain situations DOC may not be able to select some of the switching and protection
devices.
The main cases are explained in chapter 4.3.
The results available at the end of the calculations and the methods for displaying them are
described in chapter 3.7.
The main actions that can be taken at the end of the calculations to check the results and,
where necessary, to change the program selections, are described in chapter 4.5.
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4.2. Error Messages

This chapter explains the most important and frequent error messages that can appear during
the calculations.
These error messages are of two types:

· Blocking messages: warn  of  a  critical  and  incorrect  situation  that  must  be  corrected
before being able to proceed with the calculation.

· Warning messages: draw the user’s attention to a faulty or potentially incorrect
situation but do not block the calculation process.

Blocking messages
· Phases – Distribution system not consistent in highlighted Objects

DOC checks the congruence of the single-line diagram (for example: a single-phase cable
cannot supply a three-phase load).
Solutions: check the phase and distribution system properties in the Single Objects
indicated. If there are discrepancies, cancel and draw new the Single Objects or change the
Phase and Distribution system properties after having performed a Multiple selection (Cf.
Chapter 3.6) of the Single Objects involved.

· Single-line diagram incorrect: a busway must be added between supply and loads.
Check Highlighted Objects

DOC needs at  least  one Single  Object  with  impedance not  nil  (for  example,  a  cable  or  a
busway) to be present between supply and loads.
Solution: make sure that there is at least a cable or busway between the supply and loads.

· Single-line diagram incorrect: a busway must be added between two supplies. Check
Highlighted Objects

DOC needs at least one Single Object with non-nil impedance (for example, a cable or a
busway) to be present between two supplies that operate in parallel.
Solution: make sure that there is at least a cable or busway between the two power
supplies.

· Single-line diagram incorrect: some objects are short-circuited! Check Highlighted
Objects.
DOC checks that there are no branches with nil impedance in parallel with Single Objects
or branches of the plant: current would not, in fact, pass through these latter and this
would indicate an error in the single-line diagram drawing.
Solution: check the connections between the two short-circuited Single Objects.

· Single-line diagram incorrect: connections missing. Check Highlighted Objects
Part of the single-line diagram is not connected to the supply.
Solution: connect the Highlighted Single Objects to the supply.

· Single-line diagram incorrect: links not connected. Check Highlighted Objects
A link has not been connected to the relative arrival.
Solution: check the link indicated and connect it to another link; should the link be
superfluous, cancel it.



DOC – User manual – page 64

Warning messages
· Voltage drop higher than limit set for the highlighted Objects

DOC checks that the voltage drop percentage on each load is no higher than 4% (or than
the value entered by the user) and signals the loads for which the threshold has been
exceeded.
Solution: check the sizes of cables on the supply side of the load involved.

· Highlighted transformer is not dimensioned correctly: increase the size!
DOC checks that the transformers are able to supply the power required by the plant. The
message generally appears when the transformers have been locked with a padlock,
otherwise DOC would be able to automatically select another power transformer suitable
for the load required.
Solution: Increase the size of the transformer, check that the power of the loads and the
demand coefficients have been entered correctly.

· These objects are not protected against overload \ short-circuit \ indirect contacts
DOC checks that all the cables and switching devices are protected against faults (the
warning can be disabled in the window that displays the warning).
Solution: It is not always necessary to take measures (for example, the absence of
protection against overload in emergency configurations): users can decide, under their
own responsibility, to omit the protections when allowed by the Standards and/or plant
characteristics.
If necessary, add a protection device on the supply side of the unprotected object.

· Warning: some supplies consume power instead of supplying it
DOC checks whether power flows from the supply to the loads. If there are several power
supplies in parallel (generator and power supply) a generator may meet the power
requirements of the plant and also supply energy to the power supply.
Solutions: if you do not want the generator to supply energy to the power supply, check
the size of the generator, the power of the loads and the demand coefficients.
If it is normal for the generator to supply power to the network, the message confirms this
behavior.

· Warning: some supplies have lower rated power than that required by the plant
DOC checks that the generators and UPS are able to supply the power required by the
plant, by comparing their rating plate data with the requirements of the loads (the supply
is considered to be a generator with infinite power).
Solution: check the rating plate data of the generators and UPS, the demand coefficients
and the power consumed by the loads, in that order.

· Highlighted cables do not conform to the following dimensioning criteria:
- The carrying capacity is insufficient
- The voltage drop exceeds the set limit

DOC checks that the locked cables (Cf. Chapter 4.5) comply with the required carrying
capacity and voltage drop criteria.
Solutions: check cable data (length, insulation, method of installation) and load data; or
unlock the cable and let DOC re-calculate the section.
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4.3. Failed selection of Single Objects

DOC is sometimes unable to find a valid product, or shows the products locked by the user
with the padlock as invalid.
The most frequent cause of failed selection or verification of a product are listed below and
can help the user to modify the selection criteria appropriately.

· If the Single Object is locked with the padlock, unlock it and rerun the calculation.

· Check for the presence of appropriate protections against indirect contacts with the
power sources by means of residual current devices, when the distribution system is TT.
It may be impossible to ensure protection against indirect contacts with other protection
functions.

· If  the fault current is high (over 15kA) and the section of cable to be protected against
short-circuit is less than 4 mm2, try to rerun the calculation after having selected a cable
with a larger section and having locked it with the padlock.

· Make  sure  that  you  are  not  in  one  of  the  cases  specified  below,  for  which   suitable
products do not exist:
o 1P, 1P+N and 2P products in circuits with over 125A current (the 1P, 1P+N and 2P

devices are the modular type and have 125A maximum rated current. 3P, 3P+N or
4P devices must be selected).

o Residual current protection with over 2000A rated current (the maximum size of an
RCQ external toroid is 2000A).

o Fuses  with  over  630A  rated  current  (the  maximum  rated  current  of  the  fuses
managed by DOC is 630A).

o Fuses with over 100kA breaking capacity (the fuses have 100kA breaking capacity. If
DOC has calculated higher short-circuit currents, check the supply data, or select a
circuit-breaker instead of a fuse).

o Circuit-breakers with over 200kA breaking capacity (The circuit-breakers have
maximum 200kA breaking capacity. If DOC has calculated higher short-circuit
currents, verify the supply data).

o Moulded-case circuit-breakers with over 160A rated current for protecting residual
current circuit-breakers (residual current circuit-breakers cannot be protected
using moulded-case type circuit-breakers with over 160A rated current).
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o Moulded-case circuit-breakers with 160A current or less for protecting residual
current circuit-breakers with over 6kA short-circuit current (moulded-case circuit-
breakers with up to 160A rated current can only protect residual current circuit-
breakers up to 6kA).

o Miniature circuit-breakers in circuits with current over >125A or >25kA breaking
capacity. In this case, remove the limit on the type of product and allow a moulded-
case type of circuit-breaker to be selected.

· If a fuse, or a switch-fuse, protects a cable, make sure that the ratio between Iz and Ib is at
least equal to 1.2 (Cf. Chapter 5.1.1: a cable with 30A Iz can only be protected by a fuse up
to 0.9 x 30A = 27A.

· If a circuit-breaker protects a cable, make sure that there is sufficient space between Ib
and  Iz  to  be  able  to  select  a  size  of  product.  For  example:  if  Ib  is  26A  and  Iz  is  30A,  a
miniature circuit-breaker cannot be selected as protection since the closest sizes are 25A,
lower than Ib, and 32A, higher than Iz.

· Make sure that not too many objects are protected by the same protection device (the
window for displaying \ editing the list of the protections is described in Annex B).

· For the circuit-breaker, check that there are not too many simultaneous discrimination,
back-up and cable protection restrictions. In this case, slacken one or more of the
restrictions.

Help for failed selection of Single Objects

If you are unable to select a product using the suggestions given above, you can the send the
project file and a description of the problem to the assistance service, which is at your
disposal.
The address is as follows: software.tools@it.abb.com

mailto:software.tools@it.abb.com
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4.4. Calculation and dimensioning results

Calculation results
DOC calculates the following, both in low and in medium voltage:
· Maximum short-circuit currents at all points of the single-line diagram.
· Minimum short-circuit currents at the end of the line.
· Phase and neutral currents (in unbalanced networks) at all points of the single-line

diagram.
· Power factor on each line and at each busbar.
· Active and reactive power required at the supply.

Dimensioning results
The program is able to select the following, both in low and in medium voltage:
· The minimum cable sections that comply with the following criteria:

o thermal, depending on the Standard selected
o voltage drop in the single line less than 4% (can be changed by the user)

· The most economical protection apparatus (circuit-breakers, fuses) in the list of
technically correct ABB products.

· The most economical switching apparatus (disconnectors, contactors) in the list of
technically correct ABB products.

Further results
Other results from a calculation:
· Balancing unbalanced networks. The program applies an algorithm to “move” the single-

phase and two-phase loads from one phase to the other, so that current consumption on
the supply side is as balanced as possible.

· Dimensioning  for  the  rated  current  of  a  transformer  or  generator.  The  Single  Objects
placed on the load side of a transformer or generator will be dimensioned according to
the rated current of the secondary winding of the transformer or the rated power of the
generator, rather than according to the current required by the plant.
This option is useful for those who possess machines dimensioned by considering future
plant enlargements. Cables and switching and protection devices will not have to be
changed, with obvious savings in times and costs.
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4.5. How to change the dimensioning results

This chapter explains how to change the selections made automatically by the program.

Locking and unlocking Single Objects

When program selections are changed after dimensioning, the most important commands, are
those which allow a Single Object to be Locked or Unlocked.
The “Lock objects” command changes the calculation settings, so that at the next
dimensioning, the locked Single Object is only checked and not changed by DOC.
The locked Single Objects behave as follows:

Object Lock effect
Cable The section is not re-calculated.
Protection device The product is not changed for a more economical one.
Switching device The product is not changed for a more economical one.
Transformer The size is not re-calculated according to the loads.
Load The single-phase loads are not connected to a different phase so as to

minimize the unbalance.

The “Unlock objects” command resets the calculation settings, so that at the next
dimensioning, the unlocked Single Object is selected by DOC.
The unlocked Single Objects behave as follows:

Object Lock effect
Cable DOC re-calculates the section and optimizes it according to the voltage

drop and the carrying capacity
Protection device The most economical product among those technically suitable is

proposed.
Switching device The most economical product among those technically suitable is

proposed.
Transformer The size is re-calculated according to the loads.
Load If it is single-phase, it can be connected to a different phase to

minimize the unbalance.
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Changing product
The automatic selections made by DOC cannot take the requirements of all program users into
account!
To change a product proposed by DOC, simply:
· Access the Single Object Properties window.
· Click over the “Select >>>” button
· Navigate the tree to find the desired product.
· Lock the desired product with the padlock.

On access to the selection window, the list of products displayed considers the technical
selection filters of the product itself (for example, circuit-breakers with breaking capacities
lower than the short-circuit current will not be shown).
If  the  desired  product  is  not  in  the  list,  remove  the  technical  filters  by  selecting  the  “Free
selection” option at the top left.

“Select >>” button in a circuit-breaker window

At the next calculation, DOC will check the locked product instead of selecting a new one.

Changing cable sizes
DOC selects the cable sections according to the Standard, the carrying capacity of the cable and
the voltage drop.
You can change the cable sections, for example, to check a cable already installed, by accessing
the cable Properties window.
Select the most suitable sections for your situation in this window and lock the selection with
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the padlock.

Cable dimensioning window – changing the cable sections

When the section of a cable is changed, the impedance of the cable and, therefore, the
voltage and short-circuit values on its load side also change.
New values for the short-circuit currents could invalidate the selections made for the already
selected protection devices: it will therefore be necessary to re-calculate the whole single-line
diagram !
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5. Verifications and protections

This chapter describes:
· verification of overload, short-circuit, indirect contacts and discrimination from a theoretical

viewpoint;
· the verifications performed by the program.

After reading this chapter, the user will be able to:
· understand the overload, short-circuit, indirect contact and discrimination verifications;
· use the curves module to perform overload, short-circuit, indirect contact and discrimination

verifications.
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5.1. Verifications and protections

This chapter describes how to check the cable protection and the discrimination criteria by
means of the module dedicated to drawing curves.

5.1.1. Description of the Protections

DOC checks, in real time, the protections against:
· Overload (hereinafter OL).
· Short-circuit (hereinafter SC).
· Indirect contacts in TT systems (hereinafter NDT-TT).
· Indirect contacts in TN systems (hereinafter NDT-TN).

The protection criteria are defined in standard IEC 60364-4-43:

· Overload (Standard IEC 60364-4-43 Chapter 433):
- The set current of the protection device (In) must be between the service current

(Ib) and the carrying capacity of the busway (Iz).
IzInIb ££

- The threshold of guaranteed tripping of the protection device must be less than
1.45 times the carrying capacity of the busway.

IzIf ×£ 45.1
where:
Ib = Service current.
Iz = Carrying capacity in permanent regime of the busway.
In = Current set of the protection device (for non-adjustable protection devices,
this coincides with the rated current).
If = Current which ensures effective operation of the protection device within
the prearranged time under defined conditions.

Guaranteed tripping current for circuit-breakers and fuses

For construction characteristics, guaranteed tripping current If is:
- Always In×45.1  or less for circuit-breakers
- In×6.1  for fuses.
This means that:
- A circuit-breaker is able to protect a cable against overload over the whole of its carrying

capacity, thus making verification superfluous IzIf ×£ 45.1
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- In a fuse, the most stringent condition is verification on If. If If is substituted with value 1.6
In, you obtain:

IzIn ×£× 45.16.1
Which means that:

IzIn ×£ 906.0

In other words, protection of a cable against overload by means of a fuse does not allow this
cable to be used up to its carrying capacity, but only up to about 90% of its carrying capacity.

· Short-circuit (Standard IEC 60364-4-43 Chapter 434):
o The specific energy let-through by the protection device is less than the specific energy

supported by the cable for all the current values from Ib to the maximum short-circuit
current.
With DOC, verification is performed graphically by comparing the curve of the specific
energy let through by the circuit-breaker (I2t) and the curve of the maximum energy
which can be supported by the cable (K2S2), and by checking that there are no
intersections in the range of currents defined by the Standard.

Energy diagram: comparison of the curves of a circuit-breaker (blue) with a completely
protected cable (black) and a partially protected cable (red)
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· Indirect contacts in TT systems (Standard IEC 60364-4-43 Chapter 413):
o The contact voltage is less than 50 [V], i.e.:

50£× IaRa
where:
RA [Ω] = Sum of the resistances of the earth electrode and protection conductors of the
exposed conductive parts.
IA [A] = Current which causes automatic operation of the protection device (if the
protection device is the residual current type, IA is the Idn rated residual current Idn).
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Modification of the RA value

As described in the previous section, RA is  given  by  the  sum  of  two  resistances:  the  earth
electrode and the protection conductors of the exposed conductive parts.

· Earth electrode: its value is defined using the command “Options” under the item
“Protection against indirect contact” (Cf. Chapter 2.1).

Window for setting the RA value

If necessary, you can set a different earth electrode value for each single feeder in the
“Protected Objects”  window  of  the  protection  device  (“LV circuit-breaker”,  “LV Fuse”,
“Residual current circuit-breaker”) on the supply side of the feeder itself.
· Protection conductors of exposed conductive parts:  the  resistance  value  of  the  the

conductors is calculated by the program depending on the type of cable and its section.
The conductor resistance values can be

o Consulted in the “LV cable” properties (Cf. Annex B);
o Printed in the Error! Reference source not found. section Error! Reference

source not found.).
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· Indirect contacts in TN systems (Standard IEC 60364-4-43 Chapter 413):
o The trip threshold of the protection device must be lower than the fault current at the

end of the Phase – Earth line, i.e.:
UoIaZs £×

where:
ZS [Ω] = Impedance of the fault ring which includes the source, the live conductor as far
as the fault point and the protection conductor between the fault point and the source
(in  DOC,  this  type  of  fault  is  called  “L-PE”, i.e. between phase and protection
conductor).
IA [A] = Current which causes automatic operation of the protection device within the
time defined in the following table (if the protection device is the residual current type,
IA is the rated residual current Idn).

Uo [V] Tripping time [s]
120 0.8
230 0.4
400 0.2

>400 0.1

U0 [V] = Rms value of the rated voltage between phase and earth.

DOC calculates value ZsUo , indicated as “Icc L-PE” (short-circuit fault current
between Phase and Protection conductor). The verification performed is therefore:

PEIccL -£Im
where:
IM [A] = is the current which causes the protection device to trip within the scheduled
tripping time.
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· Indirect contacts in IT systems (Standard IEC 60364-4-43 Chapter 413):
o In  IT  systems  the  live  part  of  the  network  is  electrically  insulated  from  the

exposed conductive parts, therefore the circuit of any possible earth fault can
only be re-closed in capacitive couplings between live conductors and exposed
conductive parts or earths (as in the diagram below).
The  value  of  these  capacitive  couplings  is  not  easy  to  calculate,  so  it  is
impossible  to  give  a  value to  the impedance of  the fault  ring  and therefore to
the current which passes through it.

Circuit of an earth fault in an IT system

Since the value of the first earth fault is not known, DOC is unable to check the
protection against indirect contacts.
Remember that, in any case, the above-mentioned Standard envisages the use
of an insulation control device to indicate the appearance of an initial fault
between a live part of the network and exposed conductive parts or earth.
The same Standard does not impose protection against indirect contacts in IT
systems by means of automatic interruption of the power supply.

The parameters used for verifying protection against indirect contacts can be changed in the
“General plant properties” window (Cf. Chapter 2.1).

Further information about protection against indirect contacts

For further details, we recommend consulting the “QT3 - Distribution systems and protection
against indirect contacts and earth faults” guide.
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5.1.2. Protection devices

The protection devices are able to supply the types of protection listed in the table below

Protection device SC CC CI-TN CI-TT
Thermal-magnetic circuit-breaker X X X
Thermal-magnetic circuit-breaker with residual current X X X X
Magnetic only circuit-breaker X X
Magnetic only circuit-breaker with residual current X X X
Residual current circuit-breaker X
Fuse X X X
Switch-fuse X X X
Thermal-magnetic motor protector X X X
Magnetic only motor protector X X
Thermal relay X

DOC automatically assigns cable protection to the most suitable device on the supply side.
However, the program selections can be changed by pressing the “Advanced Options >>>” or
“Protected Objects” buttons, which are always present in the windows dedicated to each
protection device.

Removal of the protection restrictions of switching devices or busways could leave these
objects unprotected in the case of a fault.
You are advised to use this option very carefully.
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Window for assigning the protections.
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5.1.3. Protection verification

Curves module manual

This Chapter only contains basic indications about using the curves module.
For a detailed explanation about how to set the releases and on the functionalities of the
application, please consult the “Curves Manual” under the “Help Curves”  item of  the “INFO”
tab of DOC).

Protection verification is performed with the curves module, which is enabled by clicking over
the “Curves” icon of the “Tools” menu in the “HOME” tab (shown on the left).

Once the command is  given,  DOC displays  a  new work environment where you can work on
the curves of the devices in the diagram and on all the available settings

Main curves module window.

“Relations”,  i.e.  the  list  of  protections  verified  by  DOC,  are  shown  in  the  lower  part  of  the
screen.
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The “Relations” window is divided into four columns:
· Object on the supply side (protection device, a circuit-breaker or a fuse).
· Object on the load side (object protected, typically a cable).
· Corroborating calculation performed by DOC (the calculation is made in real time as soon

as a curve is changed and in conformity with the previously described criteria).
· Present state of the verification.

If a protection relation is satisfactory, the text which describes it is black and the state is “OK”.
If a protection relation fails, the text which describes it is red and the state is “Failed”.

You can print  the results  of  all  the verifications  made by DOC in  Print  of  the Error! Reference
source not found. section (Cf. Chapter Error! Reference source not found.).

Examples of satisfactory and failed verifications
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5.1.4. Management of the protection device settings

When a protection relation fails you can proceed according to the indications given below so
as to understand the reasons for this and take the appropriate measures to make it
satisfactory

Verification of protection against overload

Overload verification

· Select the failed verification by ticking its box;
· The curves module will show the Time-Current diagram (I-t);
· The protection device and the cable to which the verification refers will be shown;
· Double click over the curve of the protection device;
· Change the setting of the thermal threshold (“L” threshold) until the current setting

between “Ib” (load current) and “Iz” (cable carrying capacity) falls;
· The color of the message will change in real time from red to black, when the protection

relation has been verified.
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Verification of protection against short-circuit

Short-circuit verification

· Select the failed verification by ticking its box;
· The curves module will display the diagram of the specific let-through energy (I-I2t);
· The protection device and the cable to which the verification refers will be shown;
· There may be large circuit-breakers  fitted with electronic  releases:  in  this  case enable

functions “S” and “I” of the electronic release and change the setting until the circuit-
breaker curve is completely under the cable curve;

· The  color  of  the  message  will  change  in  real  time  from  red  to  black,  when  the
protection relation has been verified.
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Verification of protection against indirect contacts

Indirect contact verification

· Select the failed verification by ticking its box;
· The curves module will display the Phase-earth fault current – Time (I-t LPE) diagram
· Select the circuit-breaker curve by clicking over it;
· Click over the “min Ik” icon: the command makes a vertical straight line appear on the

diagram which represents the fault current at the end of the line. A positive
verification is obtained when the magnetic threshold of the circuit-breaker is on the
left of the fault current at the end of the line;

· Lower the magnetic threshold of the thermal-magnetic releases, or enable thresholds
“S” or “I” of the electronic releases and use sufficiently low setting values;

· The  color  of  the  message  will  change  in  real  time  from  red  to  black,  when  the
protection relation has been verified.
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Discrimination verification

Discrimination verification

Discrimination is achieved when both the following conditions are satisfied:
· The circuit-breakers have been selected by assigning them the discrimination restriction

in the single-line diagram (Cf. Annex B, “LV circuit-breaker” chapter).
· The curve of the circuit-breaker on the supply side, in the Time-Current diagram, does

not intersect that of the circuit-breaker on the load side

When the program warns that discrimination verification has failed, it is advisable to proceed as
described below:
· Select the failed verification by ticking its box;
· The curves module will display the Time-Current diagram (I-t)
· Double click over the circuit-breaker on the supply side to access the window where its

release is set.
· If the release is the thermal-magnetic type (“Circuit-breaker with thermal magnetic relay”),

raise threshold “I” up to the maximum value allowed.
· If  the  release  is  the  electronic  type  (“Circuit-breaker with electronic relay”), disable

function “I”;
o Once function “I” has been disabled, it is advisable to enable function “S” (protection

against delayed short-circuit);
o Raise threshold “S” both as to time and current until discrimination is obtained.

· The color of the message will  change in real time from red to black, when the protection
has been verified.
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The hatched area appears in the diagram when a discrimination verification has been selected.
This area represents the maximum discrimination value which can be achieved by the pair of
circuit-breakers.

The maximum discrimination value is defined as:
· The magnetic setting of the circuit-breaker on the supply side minus the tolerance, if:

o The circuit-breaker on the supply side has an electronic release and function “I” is
enabled;

o The circuit-breaker has a thermal-magnetic release and the magnetic threshold “I”
setting is lower than the maximum value allowed.

· The discrimination value published in the ABB “Coordination Tables” if:
o The circuit-breaker on the supply side has an electronic release and function “I” is

disabled;
o The circuit-breaker has a thermal-magnetic release and the magnetic threshold “I”

setting equals the maximum value allowed.

Further Information about discrimination verification

The  “QT1 - Discrimination in low voltage with ABB circuit-breakers” guide is available in the
“Help” menu. You are advised to consult it for in-depth information on the subject.

Discrimination studies between MV Apparatus and LV Apparatus

The “QT2 - MV/LV Substations: theory and short-circuit calculation examples” guide is available
in the “Help” menu. You are advised to consult it for in-depth information on the subject.

Inability to verify all the relations

It may not be possible to satisfy all the protection relations simultaneously, since a setting
made to satisfy one of them may not allow others to be satisifed.
This can occur, for example, if both protection against indirect contacts and discrimination
with circuit-breakers on the load side must be guaranteed using the same protection device:
the former requires a low magnetic setting, whereas the latter requires high values or
disablement of function “I”.
It is advisable to:
· Replace the thermal-magnetic releases with microprocessor ones, which have more

options during the setting stage.
· Use  releases  with  the  “G”  function,  which  allows  you  to  have  high  magnetic  settings  for

discrimination verification and low magnetic settings for protection against indirect
contacts.
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Back-up verification

DOC is able to select circuit-breakers coordinated by means of back-up.
This relationship does not require any further verification: back-up is a function of the
construction characteristics of the circuit-breakers and does not depend on the release
settings.
The back-up value is declared by the Manufacturer in the ““Coordination Tables”.

Use with Ekip Connect of the circuit-breaker settings obtained with DOC

DOC files can be opened with the Ekip Connect application for the purpose of managing the
electronic settings of ABB apparatus: the settings calculated by DOC will be visible to the
application and can be transferred to the apparatuses after the required verifications have
been performed by the user.
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5.2. Data export options of the curves module

5.2.1. Exporting data from the diagram

The curves module has two commands for exporting the diagram (“Copy graph”) and the
setting values (“Copy values”).

Once copied, the graph or values are pasted into any application which supports MS
Windows copy-paste.
Using these commands, you can create a customized document containing:
· The diagram shown on screen;
· The settings of the objects in the diagram;
· The verification currently selected (in this case, the objects visible will only be those

involved in the relative verification).

Document created by copy-paste of values and graph
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5.2.2. Copying the diagram onto the single-line diagram

From the curves module, you can add the diagram currently displayed onto the single-line
diagram, by means of the “Draw” icon.

Comply with the instructions below to draw a diagram in the single-line diagram:

· Select the page of the single-line diagram where you want to add the diagram, or create a
new one.

· Launch the curves module.
· Select the objects to be displayed in the diagram.
· Select the “Draw” command.
· DOC will temporarily show the single-line diagram.
· Give an initial click to determine the vertex at the top left of the diagram.
· Give a second click to determine the second vertex of the diagram. After the second click,

DOC will show the new curves module

Diagram drawn in the single-line diagram
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6. Drawing diagrams of auxiliaries

This chapter describes:
· the drawing functionalities not included in the power diagram.

After reading this chapter, the user will be able to:
· add purely graphic symbols to the diagram;
· draw simple key diagrams.



DOC – User manual – page 91

6.1. Drawing the key diagram of the auxiliary circuits

This chapter describes how DOC can be used for drawing key diagrams.

6.1.1. Symbol toolbar for key diagrams.

When drawing key diagrams, the first step is to access the “Other apparatus” menu of the “LV
SYMBOLS” tab of the Ribbon area.
The “Measurement”, “Control” and “Symbols” menus will now be available to the users.

 “Measurement” menu

“Control” menu
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“Symbols” menu

The devices in the “Control” and “Measure” menus must be completed with the product
codes by means of the automatic window that DOC 3 automatically proposes.
Apparatus/devices with only one connection point need not be connected to the network
obligatorily. On the other hand, devices with 2 connection points must be added to the
network context so that they are shown to be correctly connected to it.
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Key diagrams obtained with the “Symbols” menu allow you to draw purely Graphic Objects.
Purely Graphic Objects are not considered in the drawing of the power single-line diagram,
thus they do not affect the calculations in any way.

Use of the devices in the “Control” and “Measure” menus

Entry in the diagram of any of the devices in the “Control” and “Measure” menus results in
automatic opening of a specific window for selecting products. In practice, the user is
allowed to match the symbol to an ABB product.

Product window that opens when a voltmeter is added to the diagram

Apparatus/devices with one single connection point need not be connected to the network
obligatorily.
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Volmeter, push-button, transformer and indicator light: examples of devices that are not
obligatorily connected to the network

Apparatus/devices with 2 connection points must be connected to the network obligatorily

Disconnector, step-by-step relay, energy meter, voltage switch: examples of devices that
must be obligatorily connected to the network

All apparatus defined by means of the “Control” and “Measure” menus are available to the
user when the switchboard fronts are defined.

Connection of auxiliaries in the symbols menu
“Connection of auxiliaries” in the symbols menu is a particularly important graphic object
since it represents the line that must be drawn in order to connect the objects in the
auxiliaries diagram together.
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6.1.2. Drawing of key diagrams

1) Select “Connection of auxiliaries” and draw the main lines of the diagram.

Main lines of a key diagram

2) Add the contacts and coils that must be drawn.

Diagram with contacts and coils
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3) Close the diagram by adding “Connections of Auxiliaries”

Complete diagram

4) Finish the diagram by adding any “Push-buttons” required.

Complete diagram with push-buttons

5) Enter any explanatory texts required by means of the “Text” command in the “Tools” menu.
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Diagram with texts

Example of motor start-up.
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7. Printing of documentation and management of the design
pages

This chapter describes:
· creation of documentation;
· the diagram and documentation printing functions;
· the diagram and project data exportation functions.

After reading this chapter, the user will be able to:
· use the “Print manager” command in Quick access;
· create the documentation of the single-line diagram;
· fill in the layouts to customize the printout;
· export the documentation in .xls format
· export the diagram and documentation in .pdf. format

Printer configuration

Before printing, you must configure your predefined printer.
Use the “Print manager->Printer options…” command in Quick access. The command for setting
up the predefined printer is also available in the “Print manager” window
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7.1. Print manager

Once the drawing, calculation and verification stages of the plant are completed, you can
proceed to print the project documentation.
The printing functions are available using the “Print manager” command in Quick access.

With DOC, the project does not only comprise the single-line diagram, but also of other sections
which can be included and then printed as you like.
The Sections available are:
· Header (Cf. Chapter 7.2.1 “Header”);
· Dimensioning and verification criteria (Cf. Chapter 7.2.2 Printout of “Dimensioning and

verification criteria” section” section);
· Short-circuit calculation hypothesis (Cf. Chapter Error! Reference source not found.

Error! Reference source not found. section);
· Single-line diagram;

and with regard to Reporting…

· Utility
· Transformers
· UPS
· Short-circuit currents (IEC1363)
· Short-circuit calculation (Cf. Chapter Error! Reference source not found. Error!

Reference source not found. section);
· Cable protection
· Busbar duct protection
· List of MV products (Cf. Chapter 7.2.5 Printout ofPrintout of the “List of MV devices” and

“List of LV devices” sections);
· MV circuit-breaker-relay table (Cf. Chapter 7.2.6 Printout of the  “List  of  MV  Circuit-

breakers and relays” section);
· List of LV products (Cf. Chapter 7.2.5 Printout of the “List of MV devices” and “List of LV

devices”);
· List of LV circuit-breakers (Cf. Chapter Error! Reference source not found. Error!

Reference source not found.);
· List of LV cables (Cf. Chapter Error! Reference source not found. Error! Reference source

not found.);
· Busways
· Back-Up
· Discrimination
· Loads
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· List of Drives and Motors

To add a Section to the project, simply click over the ticking off box on the left of each Section.
This will generate one or more pages, whose previews will be immediately visible in the central
part of the “Print manager”.

Print manager: the list of the Sections available is visible on the left with the relative ticking off
box to include  / exclude them from the documentation
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7.2. Creation of the project documentation

“Print manager” allows you to add and remove sections to and from the project document you
intend to print. The sections added to the project document will be displayed in print Preview.

The program proposes three header sections for the project and seventeen technical sections
for printing all the accumulated codes, calculations and verifications

A series  of  print  examples  of  the project  headers  and certain  of  the more significant  technical
sections is given below.

“Single-line Diagram” section

The “Single-line diagram” section is the only one that cannot be removed from the project
because it is the essence of the project itself.
However, you can decide not to print it (Cf. Chapter 7.3).
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7.2.1. “Header” section printout

This is the first page of the project documentation and contains the user, customer and project
data.
To fill in the data, see chapter 7.4.

 Header
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7.2.2. Printout of “Dimensioning and verification criteria” section”

Describes the Standards and the main parameters used for the calculations and verifications.
Printed together with the “Cable Verification” Section, it allows the positive outcome of the
verifications to be justified.

Dimensioning and verification criteria
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7.2.3. Printout of the “Short-circuit calculation hypothesis” section

The short-circuit calculation hypothesis section takes the general conditions and the
calculation hypotheses for the maximum and minimum short-circuit currents from Standard
CEI 11-25 (CEI EN 60909).

Short-circuit calculation hypothesis
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7.2.4. Printout of the “List of LV cables” section

This presents the main data of the cables in the single-line diagram in a single list:
· Sections;
· Insulating material;
· Conductor material;
· Number of installations as defined in the selected Standard;
· Carrying capacity;
· Operating temperature;
· Dissipated power;
· Voltage drop percentage;
· Resistances and reactances.

List of LV cables
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7.2.5. Printout of the “List of MV devices” and “List of LV devices” section

The two Sections provide the lists of MV and LV devices in the single-line diagram, complete
with ordering codes and description.

List of LV devices
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7.2.6. Printout of the “List of MV Circuit-breakers and relays” section
Provides the list of the “MV Circuit-breakers”, MV relays with relative CT and HCT and shows the
setting of each individual relay grouped together by function.

List of MV circuit-breakers and relays



DOC – User manual – page 108

7.2.7. Printout of the “List of LV circuit-breakers” section

Provides the  list  of  “LV circuit-breakers”  and  the  settings  of  the  relative releases grouped
together by function.

Table of LV circuit-breakers
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7.2.8. Printout of the “Short-circuit calculations” section
The short-circuit and peak currents for three-phase, two-phase, phase-neutral and phase-PE
faults are indicated for every switchboard in the single-line diagram

Short-circuit calculations

How to print a short-circuit result in any point of the diagram

A “Busbar” Single Object must be added at the point where you want to verify the short-circuit
value: DOC interprets the “Busbar” Single Object as a new Switchboard, which will be added to
the list of Switchboards in the “Short-circuit calculations” Section.
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7.2.9. Printout of the “Verifications table” section

This shows the state of the verifications of the protection reports for every “LV cable” drawn in
the single-line diagram.
The verification table consists of:
· User data
· Cable data
· Protection device data (circuit-breaker or fuse)
· State of the verification of protection against SC, CC, CI-TN, CI-TT

The state of the verifications can be:
· “OK” if the verification is positive
·  “-“ in the case of negative verification

Verification report

The “OK”s are not shown

When DOC fails to show the “OK”s in the report, the cable protection must be verified by
accessing the curves module at least once (Cf. Chapter 5).



DOC – User manual – page 111

7.3. Print Preview

The central part of the “Print manager” shows the print Preview of all the pages created, both
of the single-line diagram and the project document sections.
You can create selection groups consisting of one or more pages in the print Preview area.

Advice about Page selection

As well as the “Select all” and “Deselect all” commands, which allow all the Pages of the project
to  be  selected  and  deselected,  you  can  use  the  SHIFT  and  CTRL  keys  to  select  several  Pages,
even when they are not next to each other.

Keep CTRL pressed and click over a Page, to add this latter to the list of Pages selected. If  the
page has already been selected, it will be deselected.

You can add several pages to the selection using the SHIFT key:
· Click over the first page you want to select;
· Keep SHIFT pressed.
· Click over the last page you want to select.

Page selected, with blue background – Page deselected, with white background
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7.4. Project documentation manager window

The project documentation manager window is enabled by means of the “Document manager”
command in the menu of the same name in the “HOME” tab of the ribbon area.

Project documentation manager window

The project documentation manager commands in this window allow you to change the
project pages as defined in the DOC project context.

List and description of the commands
· Renumber pages: Changes the single-line diagram page numbering.
· Layout selection:  similarly  to  the “Change layout – page dimensions” command in the

“Home” tab of the “Document manager” menu, changes the layout of the Pages selected in
the print preview.

· Compile layout:  allows the layout of each Page and the “Header” Section to be compiled.
Once the command has been launched, simply double click in the “Present Value” column
and type in the data.

The command has effect on the selected Pages. You can therefore select all the Pages and
compile them all at once.
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Window for compiling the layout
· Add empty page:  Adds a  page to  the single-line diagram in  exactly  the same way as  the

“Add page” command of the “Home” tab in the “Document manager” menu.
· Delete current page:  Removes  all  the  selected  pages  of  the  single-line  diagram.  You  are

therefore advised to use this command with extreme caution. If pages have been removed
by mistake, quit the project documentation manager window by clicking on the “Cancel”
button: the cancelled pages will be restored.

· Move Up – Move Down: Allow the selected pages to be moved up or down, respectively.
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7.5. Export in Excel

Use the dedicated command in the “Quick access” menu to export the diagram data in the .xls
format.

Export to MS Excel command in the “Quick access” menu

7.6. Macro Import and Export

The Macro Import and Export functions in the “Quick access” menu allow you to reuse parts of
the diagram you consider to be of particular importance.
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Macro Import - Export commands in the “Quick access” menu

The export command allows you to save the circuit part considered of interest in a specific file
in the .blk format for use later on.
The import command allows you to use the data in any other diagram required.



DOC – User manual – page 116

8. ANNEX A: List of Commands

This Annex includes the list and description of all the commands available in the Quick access menu and in
the various different tab of DOC.
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8.1. Quick access menu

This menu mainly contains the commands for managing files and for printing.
New
Creates a new project.
Before creating a new project, the program will ask you to save any changes to the present
project. None of the new projects have an associated file. Use the Save option of the File menu
to associate a file to a project.
Open…
Opens a previously saved file.
Before opening an old file, the program will ask you to save any changes to the present file.
DOC project files have “*.e-Design” extension.
Save
Saves the present project.
If the project does not have an associated  file, the program will ask you for the name and path
for saving the file. DOC project files have “*.e-Design” extension.
Save as…
Saves the present project with a different file name and/or path from the present one.
Import / Export

· Exports the drawing in the CAD *.DWG or *.DXF format
Export macro
Exports the Single Objects selected in a single Macro Object. The Macro Object is saved in a
*.blk file.
Import macro
Imports a Macro Object previously saved in a *.blk file.
Print manager
Configuration of the print options for the projects.
Quick print
Immediately prints the open project.
Printer options
Configuration of the printer used and of the most common printing options.
Options
Definition of the default characteristics of the program. The settings, by Single Object or by
functionality, allow you to customize the calculations and results of the program.

Esc
Closes the program.
You will be asked to save the project if this has not already been done or if it has been changed
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since the last time it was saved.
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8.2. HOME tab

The “HOME” tab mainly contains the commands for interaction with the Single Objects in the
single-line diagram.

Undo/redo MENU

Undo
Cancels the last command performed.
Redo
Re-executes the last command undone.

Clipboard MENU

Erase
Erases the Single Objects selected from the diagram. Use the Undo command if there are
errors.
Cut
Cuts and deletes the Single Objects selected and makes them available for the Paste command
Copy
Copies the Single Objects selected and makes them available for the Paste command.
Paste
Pastes the Single Objects previously Cut or Copied into the diagram. It is not available (of a
different color to the other commands) if no Single Object has been previously Cut or Copied.

Move
Moves the Single Objects selected.
Rotate
Rotates the Single Objects selected through 90°.
Stretch
Changes the length of Connections and Busbars.
Scale
Scales the dimensions.

View MENU

Zoom
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Displays part of a drawing contained in the selection window.

Zoom +

Zooms in towards the central point of the drawing.

Zoom -

Zooms out from the central point of the drawing.

Previous

Restores the previous Zoom level.

Extension

Zoom allowing all the Single Objects in the current page to be displayed.

Pan

Drags the diagram to display only the desired part.

Page

Zooms the whole page.

Regen

Cleans the “traces” left when passing from one page to another from the screen.

Tools MENU
The “Tools” menu contains the commands for managing the main functionalities of DOC in
terms of calculation, drawing curves. It also contains management of free texts added to the
single-line diagram, the properties command and switchboards command.

Lock Objects
Locks the Single Objects selected, which will not be modified in the subsequent calculations
but only verified.

Unlock Objects
Unlocks the previously locked Single Objects. An unlocked Single Object is redefined by the
program during the calculation stage.

Renumber
Changes the current numbering of the codes of the Single Objects. The new numbering will be
consecutive in the following order: from left to right, from top to bottom, from the first to the
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last page.
It only works for Single Objects drawn in the A3, A2, A1, A0 “free” layouts. Numbering in the
column layouts complies with different criteria.

Move labels
Moves the labels displayed in the single-line diagram.

Set labels
Defines which properties of which object to display in the diagram.

Properties

When performed on a Single Object, it opens the window with the relative properties.
When performed on several Single Objects, it opens the multiple property Manager window

Text

Adds  a  free  text, defined by the user, not linked to any Single Object and which can be
positioned as desired in the single-line diagram.
Text management also includes the height and the style of the text itself.
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Window for the inserting text into the single-line diagram

Text stile
Command for managing text styles, their list and functions for creating/removing a text style.
A text style contains the main information about the font used for writing the free text.
To define a text style, type in the name and click over “New”.
To use a text style, select the name of the style desired and then select the “Present” option.

Probe

Must be connected to a network to display voltage, current and phase shifts at that point.

Scenarios

Opens the window for defining the network scenarios.

Compute

Launches the calculations, as described in chapter 4.
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Curves

Displays the curves module, described in chapter 5.

Switchboards

Opens the window containing the definition of the switchboards in the single-line diagram
which, by means of the “Insert product data sheet” function, allows the user to add a
switchboard label in the single-line diagram context.
Switchboard numbering is provided by the program in the consecutive mode and can be
customized by typing in a new switchboard name.

Switchboard manager window

Documentation manager MENU

Documentation manager

Open the project documentation manager window (see chapter 9.4.)

Add page
Adds a page to the single-line diagram.
Delete page
Removes the present page from the single-line diagram. To cancel page removal, use the
“Cancel” command in the “undo/Redot” menu.

Change layout – page dimensions

Changes the layout and consequently the dimensions of the page for the current page only.
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Access project Navigator to change several pages.
Previous page
Displays the previous page.
Next page
Displays the next page.
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8.3. LV SYMBOLS tab – single objects

The  main  commands  in  the  “LV  SYMBOLS”  tab  are  listed  below.  They  mainly  refer  to  objects
used for creating LV single-line diagrams and dimensioning the relative networks.

Power Suppliers MENU
UPS
Draws the “UPS” Single Object.
Generator
Draws the “Generator” Single Object.
Transformer 2 windings
Draws the “Transformer with 2 windings” Single Object.

Wiring MENU
Cable
Draws the “LV cable” Single Object.
Busway
Draws the “Busway” Single Object
Impedance
Draws the “Generic impedance” Single Object.

Connections MENU
Busbar
Draws the “Busbar” Single Object.
Connections
Draws the “Connection” Single Object.
Dashed Connections
Draws the “Dashed connection” Single Object.
Link to vertical page
Draws the “Link to vertical page” Single Object.
Vertical page arrival
Draws the “Vertical page arrival” Single Object.
Link to horizontal page
Draws the “Link to horizontal page” Single Object.
Horizontal page arrival
Draws the “Horizontal page arrival” Single Object.
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Power devices MENU
Thermal-magnetic circuit-breaker
Draws the “LV circuit-breaker” Single Object equipped with release for protection against
overload and short-circuit.
Thermal-magnetic residual current circuit-breaker
Draws the “LV circuit-breaker” Single Object equipped with release for protection against
overload, short-circuit and residual current block.
Magnetic only circuit-breaker
Draws the “LV circuit-breaker” Single Object equipped with release for protection against short-
circuit only.
Magnetic only residual current circuit-breaker
Draws the “LV circuit-breaker” Single Object equipped with release for protection against short-
circuit and residual current block only.
Residual current circuit-breaker
Draws the “Residual current circuit-breaker” Single Object.
Fuse
Draws the “LV Fuse” Single Object.
Switch-Fuse
Draws the “LV Switch-fuse” Single Object.
Disconnector
Draws the “LV Disconnector” Single Object.
Contactor
Draws the “LV Contactor” Single Object.

Loads MENU
Generic load
Draws the “Generic load” Single Object.
Motor
Draws the “Motor” Single Object.
Lighting load
Draws the “Lighting load” Single Object.
Capacitor bank
Draws the “Capacitor bank” Single Object.
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8.4. MV SYMBOLS tab – single objects

The main commands in the “MV SYMBOLS” tab are listed below. They mainly refer to objects
used for creating MV single-line diagrams and dimensioning the relative MV-LV networks.

Devices MENU
MV Cable
Draws the “MV Cable” Single Object.
MV circuit-breaker

Draws the “MV circuit-breaker” Single Object.
MV Disconnector

Draws the “MV Disconnector” Single Object.
MV Earth switch

Draws the “MV Earth switch” Single Object.
MV Disconnector+ fuse

Draws the “MV Disconnector” and “MV fuse” Single Objects.
MV Switch Disconnector on load
Draws the “MV Switch Disconnector on load” Single Object.
MV Switch Disconnector on load + Fuse
Draws the “MV Switch Disconnector on load” and “MV Fuse” Single Objects.
CT
Draws the purely Graphic “CT” Object.
HCT
Draws the purely Graphic “HCT” Object.
VT
Draws the purely Graphic “VT” Object.
Combisensor

Draws the purely Graphic “Combisensor” Object.
Voltage divider

Draws the purely Graphic “Voltage divider” Object.
Rogowski Coil
Draws the purely Graphic “Rogowski Coil” Object.
MV generic Load
Draws the “Generic load” Single Object predefined with a specific symbol for Medium voltage.
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8.5. “INFO” Tab

The “INFO” tab includes the guides for using the program and its recommendations.
User guide in the “Help” menu
Contains the guides to using DOC, Curves and OTC.
Technical guides in the “Technical documentation” menu
Contains the versions in pdf format of the ABB Technical Application Notebooks, i.e.:

· “QT1 - Low voltage discrimination with ABB circuit-breakers”;
· “QT2 - MV/LV Substations: theory and examples of short-circuit calculation”
· “QT3 - Distribution systems and protection against indirect contacts and earth faults”

But also other technical documents, i.e.:

-“Coordination tables”, i.e. technical documentation concerning Back-up, discrimination and
other
-Italian edition of the ”Electrical Installation Handbook”
-a document concerning “Unisec typical units” for Medium Voltage secondary distribution
-a document concerning the assembly options of ABB apparatus in System pro E Power
segregated switchboards, called “Segregation forms for circuit-breakers”
-a document explaining the segregation and design rules of System pro E Power switchboards
entitled “System pro E Power segregations”

Other guides and commands in the “INFO” menu
-Using the “Warnings” command, DOC will display the recommendations for use of the
program, as in chapter Error! Reference source not found..
-The “UTE certification” item displays the program’s certification for calculations and
dimensioning issued by the French standard authority UTE, regarding standard NFC15-500.
-The “INFO” pusu-button opens a window with the version of the program, to be notified when
the Assistance service is contacted.
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8.6. MV SYMBOLS tab – Macro objects

A list of the main Medium Voltage Macro Objects in DOC is given below.
Every Macro Object represents a typical unit of ABB’s Unisec secondary distribution
switchboards

Unisec switchgear menu

BME Unit
Metering and busbar earthing unit

DRC Unit
Direct incoming with measuring and busbar earthing

Left and right DRS Unit
Riser unit with measurement
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HBC-RRC Unit
Unit with built-in circuit-breaker and disconnector + Cable inlet on the right

HBC Unit
Unit with built-in circuit-breaker and switch-disconnector

RLC-HEC Unit
Cable inlet on the left + Unit with built-in circuit-breaker and switch-disconnector

SBC Unit
SBC Circuit-breaker with switch-disconnector
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SBM Unit
Isolating unit with measurements, circuit-breaker and double switch-disconnector

SBR Unit
Reversed feeder unit

SBS Unit
Switch breaker − secƟonalizer unit

SDC Unit
Unit with switch-disconnector
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SDM Unit
Measure panel with switch-disconnector

Left and right SDS Unit
Switch-disconnector - sectionalizer unit

SFC Unit
Unit with switch-disconnector and fuses

SFS Unit
Switch fuse sectionalizer unit
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SFV Unit
Switch-disconnector with fuses - measurement

WBC Unit
Unit with withdrawable circuit-breaker

WBS Unit
Unit with withdrawable circuit-breaker - sectionalizer

Box trafo Unit
Draws the “Transformer box” Macro Object.
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8.7. LV SYMBOLS tab – Macro Objects

A list of the main Low Voltage Macro Objects in DOC is given below.
The Low Voltage Macro Objects have been made to allow users to create the majority of types
of low voltage plants.
Further information about drawing with Macro Objects is available in chapter 3.2.

Main Menu

Main thermal magnetic residual current circuit-breaker

Draws the “Main thermal magnetic residual current CB” Macro Object.

Main thermal magnetic circuit-breaker

Draws the “Main thermal magnetic CB” Macro Object.

Main fuse

Draws the “Main fuse” Macro Object.

Main switch-fuse

Draws the “Main switch-fuse” Macro Object.

Main disconnector

Draws the “Main disconnector” Macro Object.

Line without main device

Draws the “Line without main device” Macro Object.

Line with links

Draws the “Line with links” Macro Object

Link to page

Draws the “Link to page” Macro Object.



DOC – User manual – page 135

Sub-level Menu

Main second level thermal magnetic residual current circuit-breaker

Draws the “Main second level thermal magneticresidual current CB” Macro Object.

Main second level thermal magnetic CB

Draws the “Main second level thermal magnetic CB” Macro Object.

Main second level residual current CB

Draws the “Main second level residual current CB” Macro Object.

Main second level fuse

Draws the “Main second level fuse” Macro Object.

Main second level switch-fuse

Draws the “Main second level switch-fuse” Macro Object.

Main second level disconnector

Draws the “Main second level disconnector” Macro Object.

Feeders Menu

Feeder line to thermal magnetic residual current circuit-breaker sub-board

Draws the “Feeder line to thermal magnetic residual current CB sub-board” Macro Object.

Feeder line to thermal magnetic circuit-breaker sub-board

Draws the “Feeder line to thermal magnetic CB sub-board” Macro Object.

Feeder line to switch-fuse sub board

Draws the “Feeder line to switch-fuse sub board” Macro Object.
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Feeder line to fuse sub board

Draws the “Feeder line to fuse sub board” Macro Object.

Thermal magnetic residual current feeder with generic load

Draws the “Thermal magnetic residual current feeder with generic load” Macro Object.

Thermal magnetic feeder with generic load

Draws the “Thermal magnetic feeder with generic load” Macro Object.

Switch-fuse feeder with generic load

Draws the “Switch-fuse feeder with generic load” Macro Object.

Switch-Fuse + residual current feeder with generic load

Draws the “Switch-fuse + residual current feeder with generic load” Macro Object.

Feeder - fuse with generic load

Draws the “Feeder - fuse with generic load” Macro Object.

Fuse + residual current feeder with generic load

Draws the “Fuse + Residual current feeder with generic load” Macro Object.

Thermal magnetic feeder with power factor correction unit

Draws the “Thermal magnetic feeder with power factor correction unit” Macro Object.

Thermal magnetic circuit-breaker with power factor correction unit in switchboard

Draws the “Thermal magnetic CB with power factor correction unit in switchboard” Macro
Object.

Motors Menu
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Motor feeder with solely magnetic motor protector and thermal relay

Draws the “Motor feeder with solely magnetic motor protector and thermal relay” Macro
Object.

Motor feeder with thermal magnetic motor protector

Draws the “Motor feeder with thermal magnetic motor protector” Macro Object.

Motor feeder with fuse and thermal relay

Draws the “Motor feeder with fuse and thermal relay” Macro Object.

Motor feeder with solely magnetic moulded-case CB and thermal relay

Draws the “Motor feeder with solely magnetic moulded-case CB and thermal relay” Macro
Object.

Motor feeder with moulded case CB with MP release

Draws the “Motor feeder with moulded case C with MP release” Macro Object.

Star-Delta motor feeder with solely magnetic motor protector and thermal relay

Draws the “Star-Delta motor feeder with solely magnetic motor protector and thermal relay”
Macro Object.

Star-Delta motor feeder with thermal magnetic motor protector

Draws the “Star-Delta motor feeder with thermal magnetic motor protector” Macro Object

Star-Delta motor feeder with fuse and thermal relay

Draws the “Star-Delta motor feeder with fuse and thermal relay” Macro Object.

Star-Delta motor feeder with solely magnetic moulded-case CB and thermal relay

Draws the “Star-Delta motor feeder with solely magnetic moulded-case CB and thermal relay”
Macro Object.

Star-Delta motor feeder with moulded-case CB with MP release
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Draws the “Star-Delta motor feeder with moulded-case CB with  MP release” Macro Object.



DOC – User manual – page 139

9. ANNEX B: List and Description of Single Objects and their
relative control panels

The following Annex includes the list and description of the windows of all the Single Objects in the “MV
SYMBOLS” and “LV SYMBOLS” tabs.
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9.1. Windows of MV Single Objects (“MV SYMBOLS”)

This Annex contains the list and description of the windows of MV Single Objects, available
only with the Professional profile and only in projects that begin with an “MV utility”.
The windows of each Single Object can be displayed in two ways:
· By a double click over the Single Object symbol in the single-line diagram.
· Using the “Properties” command in the tools menu of the “HOME” tab

MV circuit-breaker
The following data can be defined in the “MV circuit-breaker” control panel:
· Description of the User, on two lines.
· Circuit-breaker family.
· The relay to be associated with the circuit-breaker.
· The CT (only among those compatible with the selected relay).
· The HCT (only among those compatible with the selected relay)

Main MV circuit-breaker window
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MV disconnector
The following data can be defined in the “MV disconnector” control panel:
· Description of the User, on two lines.
· The Symbol of the disconnector, upright or overturned

Main MV disconnector window
MV earthing switch
The following data can be defined in the “MV Earthing switch” control panel:
· Description of the User, on two lines.

Main MV earthing switch window
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MV disconnector with fuse
The following data can be defined in the “MV disconnector and fuse” control panel:
· Description of the User, on two lines.

Main MV disconnector and fuse window

MV switch-disconnector on load
The following data can be defined in the “MV switch-disconnector” control panel:
· Description of the User, on two lines.

Main MV switch-disconnector window
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MV switch-disconnector with fuse
The following data can be defined in the “MV switch-disconnector and fuse” control panel:

· Description of the User, on two lines.

Main MV switch-disconnector and fuse window
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MV cable
The following data can be defined in the “MV cable” control panel:
· Description of the User, on two lines.
· Ambient temperature.
· Maximum Cdt% in the length of cable.
· Length.
· Type of cable (Single-core – Multi-core).
· The maximum service temperature of the insulation (XLPE at 65°C – XPLE at

90°C).
· The installation method (Overhead installation and relative details –

Underground installation and relative details).

Main MV cable window
The  “Advanced Options >>>” button allows those data which can change the
carrying capacity of the cable, to be defined as correction factors:
· Installation details (adjacent circuits – installation depth)
· Screen data (Type and Section)
· Minimum Iz/Ib ratio

Advanced Options for the MV cable
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MV Load

The following data can be defined in the “MV Load” control panel:
· Description of the User, on two lines.
· Consumption as a function of Load current and Power factor.
· Consumption as a function of Power consumed and Power factor.
· Symbol with which the load will be displayed (a small ball - an arrow - a transformer).

Main MV Load window

Graphic symbols of the MV Load
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9.2. Windows of LV Single Objects (“LV SYMBOLS” tab)

This Annex contains the list and description of the windows of LV Single Objects.
The windows of each Single Object can be displayed in two ways:
· With a double click over the Single Object symbol in the single-line diagram.
· Using the “Properties” command of the Tools menu of the tab “HOME” tab.

UPS
The following data can be defined in the “UPS” control panel:
· Description.
· Apparent rated Power, Rated Power factor of the UPS (these two data items allow the

program to find how much active power Pn and reactive power Qn it is able to supply to
the network).

· The ratio between the short-circuit current and rated current, with which the program
calculates the contribution to the UPS fault.

Main UPS window
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Generator
The following data can be defined in the “Generator” window:
· Description of the type of generator (Model).
· The type of source, PV or PQ.

A “PV” generator will always keep the active Power and reference Voltage at its terminals
constant. Consequently the reactive Power supplied to the network will depend on the
current required by the network.
A “PQ” generator will always keep the active Power and reactive Power constant.
Consequently the Voltage at the network terminals will depend on the current required
by the network.

· “< Browse database” allows you to search for a generator in the program database.
· “>Add to database” allows the currently defined generator to be saved in the program

database. To be able to save a generator its Model must be written.

The following rating plate data:
· Rated apparent Power and rated Power factor (these two data items allow the program to

find out how much active power Pn and reactive power Qn it is able to supply to the
network).

· Loss participation factor: only for PV sources and with several generators in parallel; this
factor decides how much a generator will be loaded.

· Armature resistance in [Ω] or in [ms] of the time constant Ta.
· The Reactances can also be defined, within the scope of the “advanced options”:

Subtransient (direct axis and quadrature), Transient, Synchronous, Inverse Sequence and
Homopolar.

· The time constants: Subtransient and Transient.
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Main Generator window

Generator advanced options window

The rating plate data defined in the generator are used in the network and short-circuit
calculations.
Data not defined, or defined incorrectly, can produce results far from realty.
When these data are not known, or availability of data is incomplete, it is advisable to select
the  generator  with  the  characteristics  most  similar  to  your  own  generator  from  the  DOC
generator database, and if necessary change the characteristics provided by the program
using the data in your possession.
Standard database and user database of the generators
DOC provides users with an extensive generator database that is easily displayed by clicking on
the binoculars at the top right of the “Generator” window.

Standard generators database window
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A customized generators database can also be created to suit one's personal requirements if
necessary.
To do this, proceed as follows:

Step 1: export the data model in the Excel format using the “Export model XLS” at the bottom
right of the “User database” window.

Step 2: complete the data model obtained with the data of your generators

Step 3: using the “Import” command at the bottom right of the “User database” window, re-
import the XLS model file complete with all the data.

Generators user database window

Trasformer with 2 windings
The “Transformer with 2 windings” window allows you to define:
· Description of the type of transformer (Model).
· “< Browse database” allows you to search for a transformer in the program database.
· “>Add to database” allows you to save the currently defined transformer in the program

database. To be able to save a transformer, its Model must be written.
· The voltage levels: MV/MV, MV/LV, LV/LV (the latter can be three-phase, two-phase or

single-phase).
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· Rated power.
· Short-circuit impedance.
· Loss in the copper, defined as a percentage of the rated power or as an absolute value in

[kW] (from which the resistive modulus of the transformer impedance is found).

For the Primary and Secondary windings:
· The type of winding, only for three-phase transformers (Star, Earthed neutral, Delta).
· The rated voltage of the relative side of the plant.
· The no-load voltage, i.e. the voltage that the transformer would supply to the terminals of

the secondary winding if no load was connected.
· Definition of the sockets and any set socket.
· The number of phases.
· The distribution system.

Main window of the Transformer with 2 windings
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Standard database and user database of the transformers
DOC provides users with an extensive transformer database that is easily displayed by clicking
on the binoculars at the top right of the “Transformer with 2 windings” window.

Trasformers standard database window

You can also create a customized transformers database to suit your personal requirements if
necessary.
To do this, proceed as follows:

Step 1: export the data model in the Excel format using the “Export model XLS” at the bottom
right of the “User database” window.

Step 2: complete the data model obtained with the data of your transformers

Step 3: using the “Import” command at the bottom right of the “User database” window, re-
import the XLS model file complete with all the data.

Trasformers user database window



DOC – User manual – page 152

Generic Impedance
“Generic impedance” is used for calculating a short-circuit in which the resistance
and reactance characteristics of a cable or a busway are already known. You can
therefore define:
· Phase Resistance and Reactance.
· Neutral Resistance and Reactance.
· PE Resistance and Reactance.

Main generic impedance window

LV cable
The following data can be defined in “LV cable”:
· Description of the User, on two lines.
· Ambient temperature, to which a relative correction factor will be associated.
· The maximum Cdt% with which the single cable will be dimensioned.
· The “Cable in double insulation (Class II)” option. A cable in class II will not be

verified for protection against indirect contacts.
· Cable length.
· Type of cable, defined as

Single-core cable with sheath, single-core cable without sheath, multi-core
cable,
PVC, EPR/XPLE Insulation, Mineral Insulation,
Conductor material, in Copper (Cu) or Aluminium (Al).

· The installation method, where the multiple selections serve to direct you to
one of the methods defined in the reference Standard. Each method
corresponds to different Current Carrying Capacities, available Sections,
correction Factors.
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· The number and the section of the Phase, Neutral and PE conductors (or PEN,
in TN-C systems).

Main LV cable window
The “Advanced Options >>>” button allows you to define the data that can change
the carrying capacity of the cable:
· Installation details (adjacent circuits for several cables in the same duct or

the installation depth for underground cables).
· Presence and Data of the PE, if different from the phase and Neutral

conductors.
· Temperature performance of the insulation, to which different K2S2 values

and working temperature correspond.
· The PE option laid in the same conduit as the phases determines the K2S2 of

the PE.
· Installation symmetry considered in the reactance calculation.
· Presence of third harmonics, which will correspond to possible over-

dimensioning of the Neutral conductor.
· The minimum Iz/Ib ratio to be taken into consideration when dimensioning

the cable.
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LV cable Advanced Options

Busway
The following data can be defined in “Busway”:
· Description of the User, on two lines.
· Ambient temperature, to which a relative correction factor will be associated.
· The maximum Cdt% with which the busway will be dimensioned.
· The “Cable in double insulation (Class II)” option. A cable in class II will not be

verified for protection against indirect contacts.
· Length of the cable.
· The type of busway, defined as

Neutral section at 50% or 100%
PE in the same enclosure as the phases or in a dedicated enclosure

· The type of busway selected.
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Main Busway window
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Busbar
The “Busbar” window serves to display the values calculated by the program at a point of
the  network,  as  well  as  to  connect  several  feeders  to  a  single  main  circuit-breaker.  The
values displayed on the Busbar page are:
· Rated voltage.
· Calculated voltage.
· Phase shift between distributed voltage and calculated voltage.
· Load current Ib.
· Power factor.
· Phases and Distribution system to the busbar, inherited from the branch by which it is

supplied.
The busbar window is also used to set the Demand Factor (DF) of all loads connected to the
busbar considered.

Busbar Window
The “Corrections” button allows you to calculate:
· The  capacitive  reactive  Power  required  to  correct  the  power  factor  of  all  the  loads

connected to the busbar in question to a new Power factor.
· The Power factor which will be reached depending on the capacitive reactive Power

installed.
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Power factor correction Window
The values displayed in the Short-circuit currents page are:
· Short-circuit Ik and peak Ip current for Three-phase (LLL), Line-to-line (LL), Line-to-

neutral (LN) and Line-to-Earth (LPE) faults.

Short-circuit currents Window
You can also display the “Details…” of the short-circuit calculations:
· Short-circuit Ik and peak Ip current for Three-phase (LLL), Line-to-line (LL), Line-to-

neutral (LN) and Line-to-earth (LPE) faults.
The details show all the components of the short-circuit defined in the selected calculation
Standard.
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Window with Details of the Short-circuit currents
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Virtual probe
The “Virtual probe” window displays the values calculated by the program in any point of the
network. The values displayed in the Load-Flow page are:
· Rated voltage.
· Calculated voltage.
· Phase shift between distributed voltage and calculated voltage.
· Load current Ib.
· Power factor.

Multimeter Load-Flow window
The “Corrections” push-button allows you to calculate:
· The  capacitive  reactive  Power  required  to  correct  the  power  factor  of  all  the  loads

connected to the busbar in question to a new Power factor.
· The Power factor which will be reached depending on the capacitive reactive Power

installed.

Power factor correction window
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The values displayed in the Short-circuit currents page are:
· Short-circuit Ik and peak Ip current for Three-phase (LLL), Line-to-line (LL), Line-to-neutral

(LN) and Line-to-earth (LPE) faults.

Short circuit currents Window
You can also display the “Details…” of the short-circuit calculations:
· Short-circuit current Ik and of peak Ip for faults Three-phase (LLL), Line-to-line (LL), Line-

to-neutral (LN) and Line-to-earth (LPE).
The details show all the components of the short-circuit defined in the selected calculation
Standard.

Window with Details of the Short-circuit currents
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CB (LV circuit-breaker)
The  “CB”  (LV circuit-breake)” window displays the  data  used  by  the  program  to
dimension the circuit-breaker itself. Filters are also available to help the program to
select the most suitable circuit-breaker for the user’s requirements.
You can also define:
· Description of the User, on two lines.
The values used for selecting the circuit-breaker are:
· Load current Ib which passes through the circuit-breaker, used to determine

the size Iu of the circuit-breaker itself.
· Carrying capacity of the cable Iz, used to select the circuit-breaker with a set

current Ith lower than Iz.
· The Standard for  use of  the circuit-breaker  (Industrial  or  IEC 60497-2;  Civil  or

IEC 60898).
· Maximum fault current Max Icc, used to select the Breaking capacity
· Minimum fault current Min Icc, used to select magnetic setting Im of the

circuit-breaker (if the circuit-breaker is not equipped with a residual current
lock).

The following filters are available:
· Type: circuit-breaker with thermal magnetic release, thermal magnetic with

residual current, solely magnetic, solely magnetic with residual current. This
field is predefined according to the symbol drawn in the single-line diagram.

· Data of the accessorized residual current type:
Waveform of the leakage current detected (A, AC, B).
Tripping Characteristic (Instantaneous, Selective, Anti-disturbance).
Rated sensitivity IΔn.

· Version: Fixed, Withdrawable, Plug-in.
· The Poles (1P, 1P+N, 2P, 3P, 3P+N, 4P).
· Circuit-breaker family: Moulded-case Tmax, Modular System Pro M Compact,

Air Emax.
· Release: Thermal magnetic or Electronic.
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Main LV circuit-breaker window
The “Select >>” push-button allows you to select the desired circuit-breaker from a
tree structure.

The filters set in the main window are:
· Maintained during product selection if “Apply filters” has been selected.
· Not considered during product selection if “Free selection” has been selected.

LV circuit-breaker Selection Window
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The  “Advanced Options >>>” button allows you to define further criteria that
become part of circuit-breaker selection:
· Number of adjacent circuit-breakers, introduces derating of the carrying

capacity of the miniature circuit-breakers.
· Breaking capacity, selected between Icu or Ics. It is important to underscore

that the breaking capacity refers to the circuit-breaker functioning at the
service voltage of the plant.

· Definition of a minimum Icw short-circuit withstand.
· The list of protected objects
· The discrimination and back-up functionalities

LV circuit-breaker Advanced Options Window

The  “Protected Objects” push-button, in the “Advanced Options >>>” of the “LV
circuit-breaker” allows you to display and, if necessary, assign the protections of
cables, busways, switch-disconnectors, residual current circuit-breakers and
contactors to the circuit-breaker.
The  “Protection of people” data are taken from the General plant properties
(chapter 2.1), and can be modified. These data are used for selecting the magnetic
device and/or a possible residual current lock.
The short-circuit protections of residual current circuit-breakers, switch-
disconnectors and contactors are established according to the values and the rules
defined in the ABB coordination Tables.
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Window of Objects Protected by a LV circuit-breaker
The  “Discrimination and back-up” push-button in the “Advanced Options >>>” of
the  “LV circuit-breaker”, allows two or more circuit-breakers with discrimination
and back-up restrictions to be associated.
The discrimination and back-up values used for selecting the circuit-breakers are
given in the ABB “Coordination Tables”.
The fields displayed in the definition of discrimination are:
· Level desired: short-circuit value up to which discrimination must be verified.

“Total” means: up to calculated Icc.
· Calculated Icc: short-circuit value of the circuit-breaker on the load side.
· Level: value of discrimination between the currently selected circuit-breakers.

LV circuit-breaker Discrimination and Back-up Window
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Rc CB (Residual current circuit-breaker)
The data used by the program to dimension the residual current circuit-breaker are
displayed in the “Rc CB” (Residual current circuit-breaker) window. Filters are also
available  to  help  the  program  to  select  the  most  suitable  product  for  the  user’s
requirements.
You can define:
· Description of the User, on two lines.
The values used for selecting the circuit-breaker are:
· Load current Ib which passes through the residual current circuit-breaker, used

to determine the size of the circuit-breaker itself.
The following filters are available:
· Circuit-breaker Family: Modular System Pro M Compact, Modular System Pro

M.
· Residual current data:

Waveform of the leakage current detected (A, AC, B).
Tripping characteristic (Instantaneous, Discriminative, Anti-disturbance).
Rated sensitivity IΔn.

· Poles (2P or 4P).

Main Residual current circuit-breaker window
The “Protected Objects” push-button allows you to display and, if necessary, assign
the protections against indirect contacts of cables and busways.
The “Protection of people” data are taken from the General plant properties
(chapter 2.1), and can be modified. These data are used for selecting residual
current sensitivity.
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Window of the Objects Protected by a residual current circuit-breaker

Fuse
The data used by the program to dimension the fuse are displayed  in  the  “Fuse”
window.  Filters  are  also  available  to  help  the program to select  the most  suitable
fuse for the user’s requirements.
You can define:
· Description of the User, on two lines.
The values used for selecting the fuse are:
· Load current Ib which passes through the fuse, used to determine the rated

current In of the fuse itself.
· Carrying capacity of the cable Iz, used to select the fuse with a rated current In

lower than the Iz.
The following filters are available:
· Fuse-holder base family: closed or open bases.
· Fuse data:

Cartridge: gG for general use or aM for motor protection
Cartridge size: 00, 0, 1, 2, 3

· Poles of the fuse-holder base (1P, 2P, 3P).
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Main LV Fuse window
The “Protected Objects” push-button of the Fuse window allows you to display and,
if necessary, assign cable protections, busways, switch-disconnectors, residual
current circuit-breakers and contactors to the circuit-breaker.
The “protection of people” data are taken from the General plant properties
(chapter 2.1), and can be modified.

Window of the Objects Protected by an Fuse
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Switch-fuse
The data used by the program to dimension the switch-fuse are displayed in the
“Switch-fuse”  window.  Filters  are  also  available  to  help  the program to select  the
most suitable fuse for the user’s requirements.
You can define:
· Description of the User, on two lines.
The values used for selecting the fuse are:
· Load current Ib which passes through the switch-fuse, used to determine the

rated current In of the fuse.
· Carrying capacity of the cable Iz, used to select the switch-fuse with a rated

current In lower than Iz.
The available filters are:
· Switch-fuse family: E930, OS, OESA.
· Fuse data:

Cartridge: gG for general use or aM for motor protection
Cartridge size: 00, 0, 1, 2, 3

· Poles of the switch-fuse (1P, 1P+N 2P, 3P, 3P+N, 4P).

Main Switch-fuse window
The “Protected Objects” push-button of the Switch-fuse window allows you to
display and, if necessary, assign cable protections, busways, switch-disconnectors,
residual current circuit-breakers and contactors to the circuit-breaker.
The “protection of people” data are taken from the General plant properties
(chapter 2.1), and can be modified.
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Window of the Objects Protected by a Switch-fuse
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Disconnector
The following data can be defined in the “LV Disconnector” window:
· Description of the User, on two lines.
· Load current Ib which passes through the disconnector, used to determine the size Iu of

the disconnector itself.
The following filters are available:
· Disconnector family: Standard Disconnector, or derived from an Moulded-case circuit-

breaker or derived from an Air Circuit-breaker.
· Version: Fixed, Plug-in, Withdrawable
· Disconnector poles (3P, 4P).
· “Use Icw” and “Use Icm” serve to dimension the disconnector according to it’s short-

circuit withstand (Icw) and closing under short-circuit (Icm) characteristics. When both the
boxes are disabled, the program dimensions the LV disconnector by trying to protect it
with the first circuit-breaker on the supply side, using the data in the ABB coordination
Tables.

Main Disconnector window
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Contactor
The following data can be defined in the “LV Contactor” window:
· Description of the User, on two lines.
· Load current Ib which passes through the contactor, used to determine the

carrying capacity Ie of the contactor itself.
The following filters are available:
· Contactor Family: Industrial Contactors type A – AF,
· Contactor poles (3P, 4P).
· Contactor service: AC-1 (resistive loads), AC-3 (inductive loads).

Main Contactor window
The “Advanced Options >>>” push-button allows you to define further criteria for
selection of the contactor according to the number and frequency of operations.
Derating will show the carrying capacity Ie of the contactor.

Contactor Advanced Options Window
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Load
The following data can be defined in the “Generic load” control panel:
· Description of the User, on two lines.
· The utilization factor (UF). A 100A load with 50% UF will generate a 50A current load Ib.
· Rated load current and Power Factor.
· Rated Power and Power Factor.
· Symbol with which the load will be displayed (a ball - an arrow - a transformer).

Main Load window

Graphic symbols of the Generic load
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Motor

The following data can be defined in the “Motor” control panel:
· Description of the User, on two lines.
· The utilization factor (UF). A 100A motor with 50% UF will generate a 50A load

current Ib.
· Motor model.
· Rated voltage
· Rated apparent Power
· Efficiency
· Rated power factor
The rated current will be calculated from these data.

A motor database is also available:
· “< Load from database…” allows you to load a motor from the DOC motor

database
· “> Add to database” allows you to save the motor currently defined in the DOC

motor database. To be able to save a motor, the Model field must be filled in.

The coordination fields are only available if the motor is supplied from the Single
Objects  in  one  of  the  ABB  coordinations,  as  in  the  Motor  Feeder  Macro  Objects
(chapter 3.2).
These fields include:
· Type of starting: Direct (DOL) or Star/Delta (YD).
· Starting class: normal (class 10) or heavy-duty (class 30).
· Type of coordination: Type 1 or Type 2.

Main Motor window



DOC – User manual – page 174

The  “Advanced Options >>>” push-button allows you to define other motor
parameters.
These parameters are:
· The ratio between starting current and rated current Ilr/In
· The number of poles
· The Rotor and Stator resistances and the reactances, in ‘per unit’ (p.u.).

Motor Advanced Options Window
Standard database and user database of the motors

DOC provides users with an extensive motor database that is easily displayed by
clicking on the binoculars to the right of the “Model” option of the “Motors”
window.

Standard motor database window
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You can also create a customized motors database to suit your personal
requirements if necessary.
To do this, proceed as follows:

Step 1: export the data model in the Excel format using the “Export model XLS” at
the bottom right of the “User database” window.

Step 2: complete the data model obtained with the data of your motors

Step 3: using the “Import” command at the bottom right of the “User database”
window, re-import the XLS model file complete with all the data.

User motor database window
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Lights (load)
The “Lights” considers both the load part and the cable part of a lighting plant. The following
data are defined on the load side:
· Type of lamps.
· Rated power of each single lamp.
· The Phases loaded by the lamps.
· Number of lamps per phase.
· The length of the initial cable section as far as the first lamp.
· The distance between each lamp.

Lights window, load definition

Verify the “Cable” Single Object described in this section for the cable side.
The  length  of  the  cable  will  be  the  result  of  “Initial  length  +  (Number  of  lamps  *  Distance
between each lamp)”.
The lamp data on the cable side can be changed by clicking over the lamp-shaped icon.
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Lights Window, cable definition



DOC – User manual – page 178

Capacitor
The “Capacitor” allows the power factor to be corrected at a point in the network.
In its window, you can:
· Display the present Power factor of the busbar to which it is connected .
· Set any capacitive reactive Power value.

Capacitor window
The “Calculate” push-button allows the program to automatically select the
capacitive reactive Power required to reach a given Power factor, starting from the
present value.
By confirming the calculation with “Ok”, the calculated capacitive reactive Power
will be added to the Capacitor.

Window for automatic power factor correction
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Connection – Dashed Connection
The “Connection” and ”Dashed Connection” Single Objects are used for connecting different
Single Objects together. The demand factor can then be defined.

Connection and Dashed Connection Window

Horizontal and Vertical departure line
The  “Horizontal departure line” and  the  ”Vertical departure line” Single Objects connect
Single Objects on different pages together.
The label that identifies each departure line is assigned automatically by the program, while
the user can add a description.

Departure line Window
The “Go to” push-button links you directly to the connected arrival line.

Horizontal and Vertical arrival line
The  “Horizontal arrival line”  and  the  “Vertical arrival line” Single Objects connect Single
Objects on different pages together.
The label that identifies each arrival line is assigned by the user by means of the “Link arrival
to departure…” window.
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“Link arrival to departure…” window

The user can add a description.

Arrival line Window
The “Go to” push-button links you directly to the connected departure line.
The “…” button re-opens the “Link arrival to departure…” window.
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10. End User License Agreement

The End User License Agreement (EULA) is available online at this location.
(http://search.abb.com/library/Download.aspx?DocumentID=9AKK106103
A2575&LanguageCode=en&DocumentPartId=&Action=Launch).

http://search.abb.com/library/Download.aspx?DocumentID=9AKK106103A2575&LanguageCode=en&DocumentPartId=&Action=Launch
http://search.abb.com/library/Download.aspx?DocumentID=9AKK106103A2575&LanguageCode=en&DocumentPartId=&Action=Launch
http://search.abb.com/library/Download.aspx?DocumentID=9AKK106103A2575&LanguageCode=en&DocumentPartId=&Action=Launch
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